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Introduction

Data security nowadays is the burning issue not only for companies and government agencies, but rank and file people
as well. Our personality is now fully embedded in computer technology. It is computer you apply to when at work, it is
also computer you use at home for entertainment or as a reservoir for containing some valuable data such as personal
correspondence, banking account information, credit card numbers, financial records, whatever... It is obvious that this
kind of data should in no way be available to others. That is why, when disposing of a storage device (a hard disk or a
flash memory drive), the crucial thing is to make sure it does not contain any information, because simple deletion, or
even reformatting do not guarantee data security at all. To do that, you need a specially designed tool.

Paragon Disk Wiper™ 11 Professional is a fast, convenient and reliable solution providing irreversible destruction of data
on separate partitions or entire hard disks (IDE, SCSI, SATA, USB, etc.) as well as any type of flash memory devices.

In this manual you will find the answers to many of the technical questions, which might arise while using the program.

Our company is constantly releasing new versions and updates to its software, that's why
images shown in this manual may be different from what you see on your screen.

What's New in Disk Wiper 11

e Check FS Integrity and Data Loss Policies to let you specify the acceptable balance between the operation
performance and the risk of data loss.

e WinPE 3.0 based bootable environment to enjoy support of a wider range of hardware configurations with the
option to add drivers for specific hardware on-the-fly.

e The updated Boot Corrector for WinPE that now equals the functionality of the Linux/DOS counterpart.

e WinPE traceroute/ping utility to get detailed information on particular routes and measure transit delays of

packets across an Internet Protocol (IP) network.

e Better support for 64-bit platforms to reboot your computer to one of the three special modes (Windows
native, Linux, or DOS) to automatically complete operations, which cannot be accomplished under 64-bit
Windows.

e Support of the restart-free installation.
e AFD (Advanced Format Drive) ready.
e Support of 2TB+ and non-512B sector size drives.

e USB 3.0 ready.

Product Components
In order to cope with different tasks, the product contains several components:

e Windows based set of utilities is the crucial part of the product. With the help of an easy to use launcher you

may find and run tasks of any complexity in the field of data and system protection, hard disk partitioning and
cloning, etc.

e Linux/DOS based environment is a multi-platform bootable media that enables to run utilities under Linux or

PTS DOS, and that way to get access to your hard disk for maintenance or recovery purposes. Both platforms

Copyright© 1994-2011 Paragon Software Group. All rights reserved.
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have their strong sides, for instance Linux can boast support of FireWire (i.e. IEEE1394) or USB devices. It
enables to burn CD/DVD discs. However there can be some difficulties with detecting new hardware. DOS in its
turn has no problems of that kind but is limited in features. The Linux/DOS environment requires no installation
and can be of great help when the system fails to boot. Besides it offers a Windows XP like environment.

e WInPE based environment. Especially for keen followers of Windows, our product also offers a WinPE 3.0 based
bootable media. Unlike the Linux/DOS environment it can boast an excellent hardware support and the same

interface as the Windows version can. However its system requirements are much tougher.

Features Overview

This chapter dwells upon key benefits and technical highlights of the product.

Features

Let us list some of the features:

User Friendly Fault Minimizing Interface
e Graphical representation of the data to gain a better understanding.

e A handy Launcher to easily find and run the required tasks.

e Comprehensive wizards to simplify even the most complex operations.
e A context sensitive hint system for all functions of the program.

e Previewing the resulting layout of hard disks before actually executing operations (so-called virtual
operations).

Partition/Hard Disk Management Facilities

e Basic functions for initializing, partitioning and formatting hard disks (create, format, delete). Instead of the
standard Windows disk tools, the program supports all popular file systems.

e Mount a partition (assign a drive letter) of any file system type to make it available for your operating system.

Wipe Facilities

e Data wiping to successfully destroy all on-disk information including the standard bootstrap code and other
system service structures.

e Free space clearing to destroy any remnants of deleted files/directories left on disk without affecting the used
data.
Automatization Facilities

o Task scheduling to automate routine operations. It can be particularly effective when you have to repeat a
sequence of actions on a regular basis.

A Scheduling is only available for the Windows installation of the program.

e Scripting to make the program create a script of any set of operations you need. Besides support of all
operations available in the interactive mode, the unattended mode provides some additional features, such as

Copyright© 1994-2011 Paragon Software Group. All rights reserved.
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conditional execution, subroutines, repeatable iterations, disk/partition properties analysis, errors
management, etc.

Auxiliary Facilities

File Transfer Wizard to make such operations as transferring of files/directories or burning of them to CD/DVD

as easy and convenient as possible. Providing access to Paragon backups as regular folders, it may also help to
replace corrupted data from a previously created image in case of an operating system failure.

Wiping Media Builder to create a bootable media on a CD, DVD disc, or flash memory, which can later be used
to boot and irreversibly destroy the on-disk data. Moreover, with its help you can save data from partitions of

your hard disk directly to compact discs or burn ISO-images. The utility supports various formats of laser discs:
CD-R/RW, DVD-R/RW, DVD+R/RW, DVD-R, DVD+R double layer, Blu-ray and can handle multi-session burning.

Network Configuration Wizard to establish a network connection on a wiping media.

Boot Corrector to fix most of the system boot problems that can be a result of a human factor, program error or
a boot virus activity.

A Boot Corrector is only available for the bootable environment.

Supported Data Erasure Algorithms

US DoD 5220.22-M

US Navy standards NAVSO P-5239-26
British HMG Infosec Standard No.5
German VSItR Standard

Australian ASCI 33

Russian GOST R 50739-95

Peter Gutmann's algorithm

Bruce Schneier's algorithm

Paragon's algorithm

Custom algorithm

A To know more on the subject, please consult the Data Security Standards section.

Supported Technologies

Along with using innovative technologies from outside, Paragon has developed a number of its own original

technologies that make its products unique and attractive for customers:

Paragon UFSD™ technology to browse partitions of any file system including hidden and unmounted, modify
and copy files and folders, etc.

Paragon BTE™ technology to set tasks for execution during the system restart, thus saving from the need to use
a bootable media when modifying system partitions.

Microsoft Dynamic Disk (simple, spanned, striped, mirrored, RAID-5) to offer more management flexibility
without the partition limitation of basic disks. Dynamic storage can be particularly beneficial for large-scale
businesses when dealing with many physical hard disks involving complex setup.

Copyright© 1994-2011 Paragon Software Group. All rights reserved.
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e GUID Partition Table (GPT). It is the next generation of a hard disk partitioning scheme developed to lift
restrictions of the old MBR. GPT disks are now supported by Windows Vista/7, Server 2008, Mac OS X and Linux.
Supported File Systems
e Full read/write access to FAT16/FAT32 partitions.

e Full read/write access to NTFS (Basic Disks) under Windows, Linux and PTS DOS. Compressed NTFS files are also
supported.

e Full read/write access to Ext2FS/Ext3FS/Ext4FS partitions.

e Limited read/write access to Apple HFS+ partitions.

Unfortunately, support of non-Roman characters for the HFS+ file system is unavailable at
the moment. The company is about to implement it in the nearest future.

Supported Media
e Support of both MBR and GPT hard disks (2.2TB+ disks included)
e |DE, SCSI and SATA hard disks
e SSD (Solid State Drive)
e AFD (Advanced Format Drive)
e Non-512B sector size drives
e CD-R, CD-RW, DVD-R, DVD+R, DVD-RW, DVD+RW, DVD-R, DVD+R double layer and also Blu-ray discs
e FireWire (i.e. IEEE1394), USB 1.0, USB 2.0, USB 3.0 hard disks

e PC card storage devices (MBR and GPT flash memory, etc.)

Getting Started

In this chapter you will find all the information necessary to get the product ready to use.

Distribution
Paragon Disk Wiper 11 is distributed in two ways:
e Boxed package from Paragon Software GmbH and resellers

e Downloadable package over the Internet at the company’s web-site

Distributive CD

The boxed package includes a distributive CD that is in fact a bootable environment with auto-run of the Windows
installation, thus it can be used as a ready-made solution. But if you're going to run the Windows components, you need
to install them first (see Installation).

If you want to download an update/upgrade of the product, it will be in form of the downloadable installation package
as described in Online Distribution).

Copyright© 1994-2011 Paragon Software Group. All rights reserved.



Online Distribution

Disk Wiper 11 purchased over the Internet will be in form of an MSI package. After installing the product you can launch
the Wiping Media Builder to prepare a wiping media.

of our WinPE environment, which opens the option to prepare it on a CD/DVD/BD or a flash

t Depending on your product and edition, you might need to additionally download an image
card before installing our software.

Registration

Paragon Software GmbH provides a wide range of online services through its web-portal - www.paragon-
software.com/support/:

e Registration of new users;
e Registration of purchased products for registered users;

e Available around-the-clock downloading center, where registered users can get product updates/upgrades as
well as all the necessary documentation;

e Downloadable free demo versions and open documentation for all users.

A It is recommended to use Internet Explorer 5+ or any compatible browser.

To register as a new user

To register as a new user, please do the following:

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/;
2. Click Create of the Create a Paragon Account section;
3. Fill out a registration form;
4. Click Register.
The most important field in the form is an E-mail address, as it serves as a login to enter the system. Besides your access
password will be sent to this address as well.
To register a new product
If you are a registered user and would like to register Disk Wiper 11, please do the following:

1. Run an Internet browser and visit the page: www.paragon-software.com/my-account/;

In the Email field of the Authorization section, enter an E-mail used for registration;

In the Password field enter a password received after registration;

2
3
4. Click Signin;
5. If the user name and password are valid, you will get to your account;
6

Click Register new product of the Products section;

Copyright© 1994-2011 Paragon Software Group. All rights reserved.
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Enter your product serial number in the Serial Number field. You can find it in the product box or obtain from
your reseller. Click Next;

On the next page you will be asked to provide some additional data. Also you will need to decide whether you
want to get confirmation on registering the product by E-mail or not. Click Next, and then click Finish.

That is all. The product is now registered.

How to Download Updates/Upgrades

Downloading of updates/upgrades can be fulfilled in the following way:

1.
2.

N oo u ok~ oW

Run an Internet browser and visit the page: www.paragon-software.com/my-account/;

In the Email field of the Authorization section, enter an E-mail used for registration;

In the Password field enter a password received after registration;

Click Sign in;

If the user name and password are valid, you will get to your account;

Select My Downloads of the Products section to see what updates are available for you;

Select the desired update and click Download.

Contacting Paragon Software GmbH

If you have any questions about the company products, please do not hesitate to contact Paragon Software GmbH.

Service Contact

Visit Paragon Software web site WWWw.paragon-software.com

Registration & updates web-service WWwWw.paragon-software.com/support

Knowledge Base & Technical Support kb.paragon-software.com

Pre-sale information sales@paragon-software.com

System Requirements

For the Windows installation package

Operating systems:

- Windows XP (32 and 64 bit)

- Windows Server 2003 (32 and 64 bit)
- Windows Vista (32 and 64 bit)

- Windows Server 2008 (32 and 64 bit)
- Windows 7 (32 and 64 bit)

- Windows Server 2008 R2 (64 bit only)

Internet Explorer 5.0 or higher
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e Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed
e 128 MB of RAM (256+ recommended)
e Hard disk drive with 250 MB of available space
e SVGA video adapter and monitor
e Keyboard

e Mouse

A During the installation additional free space (up to 1GB) will be required.

For the Linux bootable environment
e Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed
e 256 MB of RAM
e SVGA video adapter and monitor
e Keyboard
e Mouse
For the WinPE bootable environment
e Intel Pentium Ill CPU or its equivalent, with 1000 MHz processor clock speed
e Atleast 512 MB of RAM
e SVGA video adapter and monitor
e Keyboard
e Mouse
Additional requirements
e Network card to send/retrieve data to/from a network computer
e Recordable CD/DVD drive to burn data to compact discs

e External USB hard drive to store data.

Installation
To install Paragon Disk Wiper 11, please do the following:

1. Run Setup Application. Click on the *.MSiI file. This application will guide you through the process of the
program installation. The setup utility is compiled with the InstallShield SDK, hence it contains the standard user
interface and set of installation steps.

In case there is some previous version of the program installed on the computer, the
program will offer the user to uninstall it first.

2. Starting Setup. The Welcome page informs that the application is being installed. Click the Next button to
continue.

Copyright© 1994-2011 Paragon Software Group. All rights reserved.
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3. Confirm License Agreement. The License Agreement page displays the Paragon License Agreement. Read the
agreement and then select the appropriate option to accept. If you do not agree with any conditions stated
there, the installation process will be interrupted. By clicking the Print button, the License Agreement may also
be printed out.

4. Provide Registration Information. On the Registration page you are to provide your product key and serial
number.

5. Provide Customer Information. On the Customer Information page you are to provide the standard
information, i.e. a user name and an organization. Besides you need to decide whether to make the program
available for all users of this computer (if several) or only for the current one.

6. Select an Installation Folder. The Destination Folder page allows you to choose a folder where the program will
be installed. By default, the installation folder will be created as:

C:\Program Files\Paragon\Paragon Disk Wiper 11. To select another folder, click the Change... button.

After you have selected the required folder, click the Next button to continue.

Do not install the program on network drives. Do not use Terminal Server sessions to install
and run the program. In both cases, the program functionality will be limited.

7. Confirm Installation. On the Ready to Install the Program page click the Install button to start the installation or
the Back button to return to any of the previous pages and modify the installation settings.

8. Copying Files. The Copying Files page shows the overall progress of the installation. Click the Cancel button to
abort the setup.

9. Finishing the Installation. The Final page reports the end of the setup process. Click the Finish button to
complete the wizard.

To accomplish online operation on locked partitions/hard disks the program uses a kernel
A mode hotcore driver, thus the system reboot is required to complete the installation
procedure.

First Start

To start Paragon Disk Wiper 11 under Windows, please click the Windows Start button and then select Programs >
Paragon Disk Wiper™ 11 > Paragon Disk Wiper™.

The first component that will be displayed is called the Express Launcher. Thanks to a well thought-out categorization
and hint system, it provides quick and easy access to wizards and utilities that we consider worth using on a regular
basis. With its help you can also start up the traditional launcher, the help system or go to the program’s home page.
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To know more on how to handle the product’s interface and accomplish typical operations,
please consult the Windows Components chapter.

Building wiping media
Wiping Media Builder can help you accomplish the following operations:

e Prepare the Linux/DOS environment (included in the installation package) on external media (CD, DVD, or flash
memory) to boot and run utilities under Linux or PTS DOS (strongly recommended);

e Prepare a custom Linux/DOS environment by adding any data you like to the standard image;
e Prepare a bootable environment from any ISO image, including our WinPE 3.0 image (strongly recommended);
e Create from the master CD the Linux/DOS or WinPE environment on a CD/DVD disc, or flash memory.
Below you can find how to build our WinPE 3.0 based environment on a thumb drive:
1. Plugin athumb drive of at least 250 MBs in size. Please note all data on that drive will be deleted.

2. Inthe Main Menu: select Tools > Wiping Media Builder...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. Onthe Wizard's Welcome page, click the Next button.

4. Select the Flash Memory option.
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@ HRash Memory

Select this option to create the recovery envionment on a flash memory media. Thus you will get al
recovery features avaiable in the program on a compact. reliable, and fast device fecommended)

CD/DVD
Select this option to create the recovery envionment on 3 CD/DVD. Thus you will 3lso get a bootable

CD or DVD with all recovery features avadable in the program (ndispensable in case your computer
does not support booting from USB drives)

5. Select the User specified CD/DVD image (.iso file) option, then browse for an I1SO image of our WinPE 3.0
environment or manually type in a full path to it. By selecting the Typical option you can build our Linux/DOS
environment, which we highly recommend you to do as well.

Typical
Use the standard Recovery Meda image supplied with the program
o User specified CD/DVD image (iso file)
Use CD/DVD image from specific location
E-/Downloads/Paragon/winpe20_BR10_Sute-eaam iso [ Browse
Copy from a CD/DVD
Choose a source CD/DVD dive

e You can get an ISO image of our WinPE 3.0 environment through the company’s web
service.

6. Select the required thumb drive from the list of flash memory devices available in the system at the moment (if
several).

Fvailable dives:
[ Drive Supported Formats

7. You will have to confirm the operation.

WARNING: As a result of this operation ALL DATA cn the flash memory media will be ERASED.
Click "OK" if you agree or "Cancel' if you do not.

l OK ] { Cancel

Booting from the Linux/DO0OS wiping media

The Linux/DOS environment can be used to boot your computer into Linux or PTS DOS to get access to your hard disk
for maintenance or recovery purposes. It also has the PTS DOS safe mode, which may help in a number of non-standard
situations such as interfering hardware settings or serious problems on the hardware level. In this case, only basic files
and drivers (such as hard disk drivers, a monitor driver, and a keyboard driver) will be loaded.

Startup

To start working with the Linux/DOS environment, please take the following steps:

1. Start up the computer from our Linux/DOS wiping media.
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Wiping Media Builder can help you prepare our environment either on a CD/DVD disc or a

f thumb drive.
To automatically boot from the wiping media please make sure the on-board BIOS is set up
to boot from CD/USB first.

2. Launch a boot mode you need (Normal, Safe, Low-Graphics Safe) in the Boot menu.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Click on the required operation to start. Hints on the selected at the moment item will help you make the right
choice.

4. Consult the help system by pressing ALT+F1 to know more on the subject.

Boot menu

The Boot menu contains the following commands:

=+ Hormal Hode Main recouvery
& Safe Mode enuironsent

& Lou-Graphics Safle Hode

& Floppy disk

& Hard disk B8 HER

& Find 0Ses on your hard disks

e Normal Mode. Boot into the Linux normal mode. This mode uses the full set of drivers (recommended);

e Safe Mode. Boot into the PTS DOS mode. This mode can be used as an alternative of the Linux normal mode if it
fails to work properly;

e Low-Graphics Safe Mode. Boot into the PTS DOS safe mode. In this case, only the minimal set of drivers will be
included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu;

o Floppy Disk. Reboot the computer from a system floppy disk;
e Hard Disk 0. Boot from the primary hard disk;

e Find OS(s) on your hard disks. The program will scan hard disks of your computer to find any bootable operating
system.

To move within the menu, please use the arrow keys of the computer keyboard.

While working with the environment you might experience some inconvenience caused by
A possible video artifacts. It is just a result of changing video modes and in no way will affect

the program functionality. If this is the case, please wait a bit and everything will be OK.
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Normal Mode

When the Normal mode is selected, the Linux launch menu appears:

BE6S

L3

— This will launch Wipe Wizard. To wipe hard

[i disk or pannion, just fllow instructions in the
wizard, All drives (including NTFS) are
already maunted as o d; & &k

File Transfer Wizard
Boot Cormector
Log Saver

Start the command line

Reboot the compiter

Power off

Wipe Wizard (enables to destroy all on-disk information or only remnants of deleted files/directories);

File Transfer Wizard (allows coping files/folders to another disk or a partition as well as recording them to
CD/DVD);

Boot Corrector (helps to correct the Windows System Registry without Windows being loaded);
Log Saver (helps to collect and send the necessary log files to the Technical Support);
Command Line (allows experienced users to execute any operation);

Reboot the computer;

Power off the computer.

To move within the menu, please use the arrow keys of the computer keyboard.

Safe Mode

When the Safe mode is selected, the PTS DOS launch menu appears. It has nearly the same functionality as for the
Normal mode except for the Network Configurator and Log Saver commands. Besides due to certain limitations of the
PTS DOS environment, there is no possibility to burn CD/DVD discs.

Low Graphics Safe Mode

When the Low Graphics mode is selected, the PTS DOS launch menu appears. It has the same functionality and looks
similar to the Safe mode but graphically simpler.
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ammrmc_I This will launch Hipe

i Hizard. To wipe hard disk
BE File Transfer Hizard or partitiom, just follow
[E] Boot Corrector instructions in the wizard.

M Connmand 1ine

& Reboot

Booting from the WinPE wiping media
The WiIinPE environment can be a real alternative to the Linux/DOS environment. Providing nearly the same level of

functionality it offers an excellent hardware support and the same interface as the Windows version does.

Startup

To start working with the WinPE environment, please take the following steps:

1. Start up the computer from our WinPE wiping media.

Wiping Media Builder can help you prepare our environment either on a CD/DVD disc or a

2 thumb drive.
To automatically boot from the wiping media please make sure the on-board BIOS is set up
to boot from CD/USB first.

2. Once it has been loaded, you will see the License Agreement. Read the agreement and then mark the
appropriate checkbox to accept. If you do not agree with any conditions stated there, you won’t be able to use
the program.

Press Page Up and Page Down to scroll the text

End User License Agreement 3
bétween

PARAGON Software GmbH,
Heinrich-von-Stephan-Str. 5 ¢, 79100 Freiburg, Germany,

and

You, as end user

If you accept the terms of the agreement, click the check box below

F[i\;;cept the terms in the License Agreement |

Accept Decline I

3. Once you accept the agreement, you will see the Universal Application Launcher. In general it enables to run
components of the product, load drivers for undefined hardware or establish a network connection.
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{3 Paragon Disk Wiper™ 11 Professional ‘ =10l x|

Paragon Disk Wiper™ 11

Professional

yearacon

Wipe Hard Disk or Wlpe Hard Disk or

B Partition

Partition

I_;_! Boot Management
# Wipe Hard Disk or Partition
o . Wipes data on your Hard disk., partition and clear free space to make
,/\ Tools | your sensitive data unrecoverable

0 Support Contacts

€ Open Advanced Interface B8 Restant [0) Shutdown

4. Click on the required operation to start. Hints on the selected at the moment item will help you make the right
choice.

5. Consult the help system by pressing ALT+F1 to know more on the subject.

Our WinPE 3.0 based environment offers excellent hardware support. However in case it
A doesn’t have a driver for your disk controller, your hard disks will be unavailable. Please
consult the Adding specific drivers scenario to know how to tackle this issue.

Basic Concepts

This chapter explains terms and ideas that show how the program works. To understand these helps to obtain a general
notion of the operation performance and makes it easier for the user to operate the program.

Data Sanitization

Data security is a two-sided problem. It is to be made clear, that providing confidentiality implies not only information to
be stored properly, but also be destroyed according to certain rules. The first step to protecting yourself is to know
exactly which security precautions work and which do not.

Many people believe the misconception that repartitioning a disk will result in complete destruction of its contents.
Actually that is not quite so. Repartitioning the drive only alters references to partitions in the Partition Table, leaving all
file data intact. In fact, there are a number of programs available to successfully recover previously deleted partitions.

Formatting a drive also does not guarantee data destruction. Formatting procedure implies modification of the Master
File Table (MFT) that keeps track of where file contents are stored on the disk and verification of each sector for
consistency. Even a low-level format does not actually erase the file contents for good, since they can still be
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resurrected from their deleted state with minimal effort by using the popular today Magnetic Force Microscopy
technology.

The only way to make sure that all the data has been erased from a hard drive is to overwrite all on-disk sectors with
random patterns of ones and zeros. Although this sounds complex, there is an easy way to do this.

The process of deliberately, irreversibly removing or destroying the data stored on a memory device (magnetic disks,
flash memory drives, etc.) is generally known as Data Sanitization. A device that has been sanitized has no usable
residual data and even advanced forensic tools should not ever be able to recover it, thus providing maximum level of
security.

Data Security Standards
To irreversibly destroy all on-disk information there have been developed a number of disk sanitizing standards. They

are distinguished by wiping patterns and number of passes:

1. US DoD 5220.22-M. US Department of Defense recommends to overwrite all addressable locations with a
character, its complement and then a random character. Finally, the target data area is to be verified,;

2. US Navy standards NAVSO P-5239-26.
e NAVSO P-5239-26 for RLL encoded drives. At first to write the fixed value (Oxffffffff) to the target data area,
then the fixed value (0x27ffffff), and then random values. Finally, the target data area is to be verified;
e NAVSO P-5239-26 for MFM encoded drives. At first to write the fixed value (Oxffffffff) to the target data

area, then the fixed value (Oxbfffffff), and then random values. Finally, the target data area is to be verified;

3. British HMG Infosec Standard No.5. At first to write a single character pattern, then its complement and then a
random character. Finally, the target data area is to be verified;

4. German VSItR Standard. Overwrite the deleted information 7 times, consistently filling it with the following
patterns: 0x00, OxFF, 0x00, OxFF, 0x00, OxFF, OxAA. Finally, the target data area is to be verified;

5. Australian ASCI 33. Overwrite with a character (C), then verify. Overwrite with —C (the first pass character’s
inverse), then verify again. Overwrite everything with both C and —C once again but without verification. Fill
everything with random characters;

6. Russian GOST R 50739-95. Destroy information by a single pass with writing random characters into each sector
byte;

7. Peter Gutmann's algorithm. A whopping 35 passes, with 27 random-order passes using specific patterns
combined with eight passes using random patterns;

8. Bruce Schneier's algorithm. Two passes of specific patterns followed by five passes using a cryptographically
secure pseudo-random sequence;

9. Paragon's algorithm.
e Overwrite each sector with a forcefully randomized 512-byte string, new for each sector, using CSPRNG
(cryptographically secure pseudo-random number generator);
e Overwrite each erased sector with its complement;

e Overwrite each sector with a 512-byte string (CSPRNG), again forcefully randomized and different from the
first pass, and new for each sector;
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e Fill each erased sector with OxAA value. Finally, the target data area is to be verified.

Military and government standards always require 100 percent residual data verification. It
is necessary to make sure that the operation has been properly accomplished. Besides
corrupted sectors discovered during the operation are to be logged to keep the user

2 informed, since these sectors may contain classified information.

The list of supported military and government standards may vary for your product.
Anyway you’ve always got the possibility to create a customized algorithm, defining up to 4
wiping patterns, number of passes for each wiping pattern and for the group of patterns,
thus providing the maximum possible security level.

Dynamic Disks

As you probably know, MS-DOS, Microsoft Windows 95/98/Me/NT/2000/XP/Vista/Server 2003/2008 support four
primary partitions per physical hard disk, one of which can be extended. Certainly there is the possibility to create
logical drives within the extended partition. Such types of disks are called basic. Windows XP Professional, Windows
2000, Windows Vista and Windows Server 2003/2008 follow the same strategy: You can have a maximum of four
primary partitions, one of which can be an extended partition with logical drives. However, these operating systems also
introduce a new disk configuration type - dynamic disk - which must be understood to effectively configure and manage
hard disks.

Dynamic disk is a physical disk that doesn't use partitions or logical drives. Instead, it contains only dynamic volumes.
Regardless of what format you use for the file system, only Win2K computers can access dynamic volumes directly.
However, computers that aren't running Win2K can access the dynamic volumes remotely when connected to the
shared folders over the network.

Dynamic disks can co-exist on a system with basic disks. The only limitation is that you cannot mix Basic and Dynamic
disks on the same hard drive.

There are five types of dynamic volumes: simple (uses free space from a single disk), spanned (created from free disk
space that is linked together from multiple disks), striped (a volume the data of which is interleaved across two or more
physical disks), mirrored (a fault-tolerant volume the data of which is duplicated on two physical disks, and RAID-5
volumes (a fault-tolerant volume the data of which is striped across an array of three or more disks).

With dynamic storage, you can perform disk and volume management without the need to restart Windows.
Limitations:

e Dynamic disks are not supported on portable computers.
e Dynamic disks are not supported on Windows XP Home Edition-based computers.

e You cannot create mirrored volumes or RAID-5 volumes on Windows XP Home Edition, Windows XP
Professional, or Windows XP 64-Bit Edition-based computers.

Thus, the dynamic disk is a new way of looking at hard disk configuration. Dynamic disks offer you more management
flexibility without the partition limitation of basic disks. Dynamic disks can contain an unlimited number of volumes, but
they cannot contain partitions or logical drives. Dynamic storage can be particularly beneficial for large-scale businesses
when dealing with many physical hard disks involving complex setup.
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GPT versus MBR

GUID Partition Table (GPT) is the next generation of a hard disk partitioning scheme developed to lift restrictions of the
old MBR. Being a part of the Extensible Firmware Interface (EFI) standard proposed by Intel to replace the outdated PC
BIOS, it offers a number of crucial benefits:

e Up to 128 primary partitions for the Windows implementation (only 4 in MBR);
o The maximum allowed partition size is 18 exabytes (only 2 terabytes in MBR);
e More reliable thanks to replication and cyclic redundancy check (CRC) protection of the partition table;

¢ A well defined and fully self-identifying partition format (data critical to the platform operation is located in
partitions, but not in un-partitioned or hidden sectors as this is the case with MBR)

64-bit Support

The bulk of software today is written for a 32-bit processor. It can meet the requirements of almost any end user.
However that is not the case when dealing with servers processing large amounts of data with complex calculations of
very large numbers. That is where 64-bit architecture comes into play.

It can boast improved scalability for business applications that enables to support more customer databases and more
simultaneous users on each server. Besides a 64-bit kernel can access more system resources, such as memory
allocation per user. A 64-bit processor can handle over 4 billion times more memory addresses than a 32-bit processor.
With these resources, even a very large database can be cached in memory.

Although many business applications run without problems on 32-bit systems, others have grown so complex that they
use up the 4 GB memory limitation of a 32-bit address space. With this large amount of data, fewer memory resources
are available to meet memory needs. On a 64-bit server, most queries are able to perform in the buffers available to the
database.

Some 32-bit applications make the transition to the 64-bit environment seamlessly others do not. For instance, system-
level utilities and programs that provide direct hardware access are likely to fail. Our program offers a full-fledged
support of the 64-bit architecture providing fault-tolerant work for such system dependent modules as Hot Processing.

Scheduling

The automation of operations is particularly effective when you have to repeat a sequence of actions on a regular basis.
For example, developing a specific project on a day-to-day basis and having to make a backup every evening so as not to
lose the valuable data, you will really appreciate, when this kind of routine operations will be carried out automatically
without your participation.

Another aspect of any automation process is that it allows an optimization of your computer’s work-load. This is
especially important when operations require a considerable amount of computer resources — processor time, memory
and more. A number of tasks, which can decrease the performance, can be run during the night or whenever the
computer has the least work-load to perform.

The program has a special tool for scheduling. You can set out a timetable for any operation and it will start at a
specified time without interrupting your current activity.

Windows Components

In the given section you can find all the information necessary to successfully work with the Windows version of the
product.
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Interface Overview

This chapter introduces the graphical interface of the program. The design of the interface precludes any mistake being
made on the part of the user. Most operations are performed through the system of wizards. Buttons and menus are
accompanied by easy understandable icons. Nevertheless, any problems that might occur while managing the program
can be tackled by reading this very chapter.

General Layout

When you start the program, the first component that is displayed is called the Launcher. It enables to run wizards and
dialogs, to specify program settings, to visualize the operating environment and the hard disk configuration.

The Launcher’s window can be conditionally subdivided into several sections that differ in their purpose and
functionality:

———— T o
=8 foR 5=

Type: Intemal Hard Disk Detve

Total size: 16GB
Sect track: 63
o hoads: 255 Explorer Bar |
l Cylinders: 2038

mmmmmmmmm& You can use one of the predefined wipe

algorthms, or create your own.
Waming: Al the data on the hard disk wil be lost without any possibilty to restore |

A FAT16 Lrusx B2 — Linux Extd
L = :

(1) No changes.

. Main Menu
. Tool Bar

. Virtual Operations Bar

. Common Tasks Bar

. Disk Map
. Legend Bar

1

2

3

4

5. Explorer Bar
6

7

8. Status Bar
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A number of panels offer similar functionality with a synchronized layout. The program enables to conceal some of them
to simplify the interface management.

All panels are separated by vertical and horizontal expandable sliders, allowing the user to customize the screen layout.

Main Menu

The Main Menu provides access to the entire functionality of the program. The available functions are as listed below:

MENU ITEM FUNCTIONALITY

Tools

View Log Files View logs on the carried out operations

Send Log Files Compress and send the log to the Paragon Support Team
Wiping Media Builder... Start up your computer for maintenance or recovery purposes
Check Recovery Discs... Verify the wiping media for integrity and ability to boot from

File Transfer Wizard... Transfer data from any media

Settings... Edit the general settings of the program

Exit Exit the program

Changes

Generate Script... Generate a script for the task

Save to Scheduler... Schedule pending operations

Undo “the last virtual Cancel the last virtual operation on the List of Pending Operations
operation’

Redo “the last virtual Cancel the last undo virtual operation on the List of Pending Operations
operation’

View Changes... Display the List of Pending Operations

Apply Changes Launch the real execution of virtual operations

Discard All Changes Cancel all virtual operations on the List of Pending Operations
Reload Disk Info Refresh the current information about disks

Wizards

Wipe Hard Disk or Destroy all on-disk information or only remnants of deleted files/directories
Partition...

Hard Disk

Update MBR Update MBR (Master Boot Record) of the selected hard disk
Wipe Hard Disk... Irreversibly destroy all on-disk information
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Edit/View Sectors...

View/edit sectors of the selected hard disk

Properties...

Get in-depth information on the properties of selected hard disk

Partition

Create Partition...

Create a partition

Format Partition...

Format a partition

Delete Partition...

Delete a partition

Assign Drive Letter...

Assign drive letter to the selected partition

Remove Drive Letter...

Remove drive letter for the selected partition

Wipe Partition...

Irreversibly destroy all on-partition information

Clear Free Space...

Destroy any remnants of deleted files/directories left on disk

Test Surface...

Test surface of the selected partition/block of free space

Check File System Check the selected partition for possible file system errors
Integrity...
Edit/View Sectors... View/edit sectors of the selected partition

Properties...

Get in-depth information on the properties of selected partition

View

Layouts Manage the Launcher layout with several predefined profiles

Toolbar Manage the Tool Bar representation: show / hide standard and navigation
buttons, text labels and large icons

Status Bar Display the Status Bar

Common Tasks Bar

Display the Common Tasks Bar

Disk Map Legend Display the Disk Map legend

Disk Map Location Select whether the Disk Map will be located on the top of the main window or
at the bottom

Help

Help Open the Help system (you can also do it by pressing F1)

About Open the dialog with information about the program

e The Main Menu contents available at the moment may vary depending on the selected

object.
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Tool Bar

The Toolbar provides fast access to the most frequently used operations:

BUTTON FUNCTIONALITY

:“31 Irreversibly destroy all on-partition
l information

@ Switch to Express launcher

Open the Help system

Virtual Operations Bar

The program supports previewing the resulting layout of hard disks before actually executing operations (so-called
virtual mode of execution). In fact, when the virtual mode is enabled, the program does not accomplish operations
immediately, but places them on the List of Pending Operations for later execution.

The Virtual Operations Bar enables to manage pending operations.

BUTTON FUNCTIONALITY

&_-'j Cancel the last virtual operation on the List of Pending Operations
(’ﬂ Cancel the last undo virtual operation on the List of Pending
Operations

() Display the List of Pending Operations

Launch the real execution of virtual operations

% Cancel all virtual operations on the List of Pending Operations

Virtual mode is an effective way of protection from any troubles, since no operations will
be executed until clicking the Apply button for confirmation, thus giving a second chance to
weigh all pros and cons of this or that particular operation. The program politely reminds
the user that there are unsaved changes by showing the following window:

A ‘1) There are unsaved changes. x

Mwmlmvmycmlocm the chenge:andthewoixcud
command to permanently undo the changes.

You can view the changes history via the .. View Changes command and

Iwwaiyuﬂoaredodwm&mbymdhh)umme Redo
commands.

Common Tasks Bar

The Common Tasks Bar is located on the left side of the main window. It is intended for easy access to the program's
wizards.
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The bar contains several tabs. Each tab includes a separate button bar which can be folded by clicking it.

Wiping Tools

flj Wipe Hard Disk or Partition Starting the Wipe Wizard to help destroy all on-disk information or only remnants
of deleted files/directories.

Starting the Wiping Media Wizard to create a bootable media which can be used
to get access to your hard disk for maintenance or recovery purposes.

ﬂ\ Wiping Media Builder

Help and Documentation

\? Disk Wiper™ Help Launching the help system (you can also do it by pressing F1).
{_'fl About Disk Wiper™ Opening the page which contains information about the program. This page will

be displayed in the Explorer Bar.

\? Data Sanitization Methodology Opening a brief review on the Data Sanitization issue.

C:f Script Marusal Opening a brief review on the Paragon Scripting Language.

Disk Map

The Disk Map is displayed in the Explorer Bar when the Disk View tab is selected. It is located either at the top or at the
bottom of the window, depending on the state of the Disk Map Location option (Main Menu: View > Disk Map
Location).

As the name infers, the Disk Map displays the layout of physical and logical disks. Physical disks are represented with
rectangle bars that contain small-sized bars. These small-sized bars represent logical disks. Their color depends on the
file system of the appropriate partition.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)
Local Disk (C:)

4999 GB NTFS
Large-sized bars display the following information about physical disks:
e Manufacturer,
e Model.
Small-sized bars display the following information about logical disks:
e Serial number,
e Drive letter,
e Totalsize,
o File system.

Furthermore, it is possible to estimate the used disk space by looking at the size of the bar’s shaded area. The program
offers to choose from several types of the disk layout scaling. It's done especially to increase the program usability. For
instance, if you’ve got a high capacity hard drive containing both very large (more than 100 GB) and rather small (less
than 10 GB) partitions, you can select the logarithmic type to make all partitions readable, otherwise (selecting the
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linear type) you won’t be able to see small partitions at all, but thing strips. On the other hand, if the proportional disk
layout is critical for you, the linear type is exactly what you need.

Nevertheless there’s a compromise solution — linear scaling with the minimal limit to small partitions. So if a partition is
too small it will remain readable.

Just click on the arrow icon on the top right side of the Disk Map to select the desired scaling type.

T |

+ Linear
Limear Scaling Min Width

T

Lirnex Ext4 ReiserFS

Disk Map is synchronized with the Explorer Bar. Thus by selecting a disk on the Disk Map, the Explorer Bar will
automatically display detailed information on it.

The drag-and-drop functionality is not available when the logarithmic type of the disk
layout is selected.

Explorer Bar

The Explorer Bar is located in the center of the main window which emphasizes its importance. The bar displays
reference information including:

e The help system
e General information on the product including its name, version and a list of helpful links
e Detailed information about disks selected on the Disk Map
e List of scheduled operations
e Disk Editor utility
According to these categories the Explorer Bar has several tabs:
e Disk View, which offers the user the following options:
- Disk Editor to view/edit sectors of the selected partition/hard disk

- Properties to view detailed information on the selected partition/hard disk in the bright graphical form

Q You can switch between these components by clicking tabs on the left side of the Explorer
Bar.

e Scheduled Tasks, which gives the user the possibility of browsing and editing scheduled operations and the
program scripts.

e Help, which contains the program help and general information on the product.
You can access the desired information by clicking on the appropriate tab.

The Explorer Bar is a fully-functional embedded HTML browser, which offers the possibility to address, for example, the
company's website to look through important technical notes or download the latest updates without having to close
the program.
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The program help is also HTML-oriented. You can read it and follow external links from to get additional information.

To easily navigate through browsed pages, the program provides the following functionality:

BUTTON FUNCTIONALITY

) Return to the previously browsed
page

(50 Open the next browsed page

(> p pag

% Stop loading the current page

Refresh the contents of the current
page

Legend Bar

The Legend Bar explains the color scheme used for disk and partition presentation. You can hide (or show) the bar with
the appropriate Main Menu item: View > Disk Map Legend. When it is activated it can be found at the bottom of the
Explorer Bar.

The program distinguishes between the following types of known file systems:
- FAT16/32
- NTFS
- Linux Ext2/3/4
- Linux ReiserFS

- Apple HFS

Status Bar
This is the bottom part of the main window. The Status Bar displays menu hints, for each item the cursor points to.

The user can hide (or show) the bar with the appropriate Main Menu item: View > Status Bar.

Settings Overview

The Settings dialog is available from the Main Menu: Tools > Settings. All the settings are grouped into several sections,
which functions are described in the following paragraphs. The list of sections is placed on the left side of the dialog. By
selecting a section from the list, you can open a set of options.

Q To get a detailed description to any setting, control, or field of the program just click the
hint button and then the object you need.
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General Options

{\g General options

Partition Abgrment Mode

Wista 3
Align partitions according to the nies usad in Windows Vista and later 05es.

Check: F5 integrity policy

Oz :!

Standard profection from data loss with acceptable pafomance. The file system
inbegrity will be checked for each volume only once just before accomplshing
data-sensiive operations

Data Loss Protection mods
Mediam protection from data loss

This section contains a set of general options that will be taken into account during any operation carried out with the
program:

e Partition Alignment mode. There are three options you can choose from:

- Legacy. DOS and Windows OSes before Vista required that partitions had to be aligned to the “disk cylinder”
or 63 sectors to address and access sectors correctly. It was OK, until 4K hard drives came into scene. When
partitions are aligned this way on this type of disk, each logical cluster is linked to two physical 4K clusters,
thus resulting in a double read-write operation.

- Vista. Since Windows Vista, operating systems do not use the archaic CHS (cylinder/head/sector) addressing
scheme, but the Logical Block Addressing (LBA), where sectors are addressed continuously over the whole
disk drive. It is optimal for both, 512B and new 4K disk drivers.

- Inheritance. Select the option to disable automatic alignment of partitions.

o Check FS integrity policy. Accomplishment of any data-sensitive operation (resize, move, merge, redistribute,
change cluster size, etc.) is potential with data loss. To minimize this risk, it’s recommended to check integrity of
your file system before this type of operations, despite the fact that it’s quite time consuming. We offer you
several options to let you choose, which is best for you:

- Always. Maximum protection, but minimal performance. The file system integrity will be checked each time
it’s necessary to guarantee the maximum protection for the on-disk data.

- Once. Standard protection with acceptable performance. The file system integrity will be checked for each
volume only once just before accomplishing data-sensitive operations.

- Never. No protection, but maximum performance. If you're not 100% sure your disk is rock solid, please do
not use this option.

e Data Loss Protection mode. To guarantee safety for your information when a data-sensitive operation has been

abruptly interrupted as a result of a computer reset, or a power outage, there are several techniques, that
correspond to the options below:

- Do not protect. No protection, but maximum performance. If you’re not 100% sure you’re completely safe
from a power outage, or an accidental reset of your computer, please do not use this option.
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- Reset. Standard protection with acceptable performance. Maintaining a special journal, our program
enables to automatically complete a data-sensitive operation interrupted by an accidental reset of your
computer from our bootable wiping media, thus reviving the corrupted partition.

- Power loss. Maximum protection, but minimal performance. Besides journaling, our program will also
disable cache of your disk when accomplishing data-sensitive operations to avoid data loss even in case of a
power outage.

Wipe Options

H Wipe options

Defauht wipe method
US DoD 5220.22M =

Crvenwrite al addressabls locations with a chamacier, s complement, then a random
character and verfy

Here you can set a specific data erasure algorithm that will be used by default during wipe operations.

A The list of supported military and government standards may vary for your product.

Wipe Report Options

fk— Wipe report structure options

Please enter customer information to put in data sanitization reports:

Customer name:

Customer onganisation
¥ you did not provide any information in these fields the defauk system data will
be displayed

Please mark the issues to be placed in data sanitization reports:

V! System information

Choose this option to put system information in report. System information
includes a computer name, OS and BIOS versions

[V] Hardware information

Choose this option to put information about hardware used in your computerin
report. This section inchudes information about processors, disk dives. network
and USB adapters etc.

V| Bad blocks information

Choose this option to put information about found bad blocks. This includes
total bad blocks count and a bad sectors kst

Supervisor Approval

Please choose this option £ wipe reports require mandatory formal approval from
an executive or supervisor. i enabled, every wipe report will contain a signature
field for a person responsible for duly data santtisation procedures in your
Company

Fort size to use when penting report: | Middle forts (12pts) [

In this section you can specify contents and properties of generated wipe reports:

e System information. Mark the option to include a computer name, BIOS version and the used operating system.
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Hardware Information. Mark the option to include information on the used processor, disk drivers, network and
USB adapters, etc.

Bad blocks information. Mark the option to include information on the found bad blocks.

Supervisor Approval. Mark the option to add a signature field for an executive or supervisor responsible for
data sanitization procedures in your company.

Font size... Select the most suitable font size from the list (12 pts by default).

Partitioning Options

Corfimations

| Agk for volume label before partition delete

Ask confirmation when comverting FAT16t0 FAT3Z2.

This section contains a set of options that will be taken into account during partitioning operations:

Request confirmation before partition deletion. Mark the checkbox to activate an additional security
mechanism. Thus when going to delete a partition you will be automatically requested to enter its label.

Request confirmation when converting FAT16 to FAT32. Mark the checkbox to automatically request
confirmation before converting FAT16 to FAT32. There are a number of situations when this kind of conversion
is the only way out to accomplish the operation. For instance, you are going to migrate your system to a larger
hard disk with the proportional resize of existing partitions, what is very convenient. As a result you can get
original FAT16 partitions go beyond the 4GB limit. Thus without conversion to FAT32, this operation will in no
way be possible to accomplish. The same goes for any copy hard disk/partition or restore hard disk/partition
operation involving an extra upsizing.

E-Mail Options

Specify your e-mail account options:
Outgoing mad sarver (SMTP)

User e-mai address

SMTP port number 25

My outgoing server requires authentication

Send test emai

Ciick this button to test e-mal account options. The program wil send generated e-mal message to
the address you've specfied in User e-mall address field

Specify e-mail notification options:
Send E-Mal notification on apply

This section contains a set of options that will be taken into account during the Send log files and Send e-mail

notification operations:
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Outgoing mail server (SMTP). To send messages by using the built-in mail client, it is necessary to have access to
a computer running an SMTP (Simple Mail Transfer Protocol) server. All outgoing messages are first sent to the
SMTP server, which in its turn delivers them to the required recipients. The address may be represented as a

traditional Internet host name (e.g.: mail.com) or as an IP numeric address (e.g. XXX.XXX.XXX.XX).

e User e-mail address. Specify an e-mail address that has been assigned by the Internet Service Provider or
organization's e-mail administrator.

e My outgoing server requires authentication. Activate the option to allow the program to make authentication

on the server before sending messages.
- User name. Enter the name that will be used to log in to the e-mail account.
- Password. Enter the password that will be used to access the mail server.
When you're ready with the settings, click on the Send test e-mail button to check if everything is OK.

e Send e-mail notification on apply. Specify an e-mail to send notifications on the carried out operations.

- Send mail in HTML format. Activate the option to create messages in the HTML format instead of plain text.

- Send complete report after applying operations. Activate the option to create an in-depth report on the
carried out operations and send it after performing the last operation.

- Send graphical view of the disk sub-system before and after apply. Activate the option to allow the program

to attach two pictures of the disk layout made before and after the operation is completed.

A By clicking the link at the bottom of the window you can jump to the Operation
. Dependency Options.

Operation Dependency Options

Operation dependency oplions

Flaase selact & lask to be camed out when one or mone of the fallowing cperations are
committed

Perom the task: | Send e-mall notfication [

Operation -
Adust 05 to boot on new hardware
Adust 05 to boot on vitual hardwane
Backup parition or disk

Baot recond comaction

Changa NTFS wersion

Change SID

Check fie system

Compact SMFT

Comnert Dynamec Disk: lo Basic

Copy partition

Copy pariition with fikes eoclusion -

) ] | [ P ) | | [ e

Selactal | [ Olearal | [Restos defaits |

This section contains a set of options that will be taken into account when the Send e-mail notification on apply function

is enabled. By marking/unmarking a checkbox opposite the required operation you can choose whether to receive an e-

mail notification on its completion or not.
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A You won't be notified if an operation requires the system restart.

Virtual Mode Options

Operations mode
J| Alow vitual mode
Set this option on to cany out all the operations vitualy. You will be able to

commit the changes or rolback all of them or the last one. ¥ you switch this
option off, the operations will be camed out immediately

Close progress dialog automatically
Set this option on to automatically close the progress dialog after committing the
changes

In this section you may configure the virtual mode:

e Allow virtual mode. Mark the checkbox to enable the virtual mode. It is an effective way of protection from any
troubles, since no operation will be executed until confirmation, thus giving you a second chance to weigh all
pros and cons of this or that particular operation.

A We strongly recommend you to enable this mode.

e Close progress dialog automatically. Mark the checkbox to automatically close the progress dialog after
accomplishing operations.

Log Files Options

“og Log files options

Choose a storage e span for the stubact og file. Please nate. once the defined pesiod
hias bean eqpirad, the: fils will be smptied.
@ Infinde
Marurnal

Custom

In this section you can specify a storage life span for the stubact.log file:
o Infinite not to empty the file ever;
e Minimal to have the file emptied all the time;

e Custom to set a certain storage life span for the file. Please note, once the defined period has been expired, the
file will be emptied.

We strongly recommend you not to choose the Minimal option, as in case of having
A problems with the program, our Support Team won’t be able to study operation logs, thus
help you out.
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Viewing Disk Properties

The main tool to view in-depth information on the properties of hard disks is the Disk Map. It represents the actual state
of the computer’s hard disks.

Generally the hard disks are represented on the map by rectangular bars, which also contain small-sized bars. The small-
sized bars represent logical disks (partitions). When you select a large-sized bar, the Explorer Bar displays information
about the disk in a bright, graphical form.

' Basic Hard Disk 1 (FUJITSU MPF3102AT)

Type: Basic Hard Disk Drive
Total size: S5GB
Seclors per track: &3
Heads: 295
Cylinders: 1245

Create an image of the entire disk
Back up 3l the data this hatd disk containg, All the pattitions on this disk will be added to the archive,

Restore an image of the entire disk
Warning: This operation wil delete all the data on this haid disk. All the pattitions will be replaced with cnes from
the image you have chosen. You may also be asked to restaet your computer during this operation

3z
&
&

Copy the entire hard disk
Create a copy of the enbire haed disk
Al the patitions on this disk wil be copied on the specified targat disk,

The model and serial number of the disk serve as the title of the browsed page. The disk layout is shown in form of a
circular graph, where the color of a sector corresponds to a file system of an appropriate partition. On the right you may
see a table, which contains the following information:

e Type of hard disk (basic or dynamic),
e Total size (in GB),
e Information on geometry of the disk (amount of sectors per track, heads and cylinders).

Below there is a list of available wizards. If you click a corresponding record the appropriate wizard will be started. All
default values for the operation parameters will correspond to the disk’s settings. The list of wizards contains a detailed
description of tasks that can be performed by the wizard. This nullifies the possibility of selecting the wrong wizard.
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' Logical Disk (G:)

Volume letter: [G:) Serial number: 7493E48F
Volume label: FAT32-LINLX Partition ID: 008 FAT32
Type: Primary Total size: 63GB
File system; FAT32 Used space: 57GB
Sectors per boot: 36 Free space: 1GB
Sectors per cluster: 8 Aclivity: Inaclive

Hidden state: Not hidden

A Create an i e of the logical disk
g Back up all the data this logical disk contains.
Restore the logical disk from an imaqe

Warning: This operation will delete all the data on this logical disk and replace them from the image you have
chosen. You may also be asked to restat your computer during this operation.

Copy the selected partition
Cieate a copy of the pattiion. A new partiion will be created and all the data will be copied there.
‘You can create an exact copy, of copy only the area that is occupied by data.

TN 3
[ D
{ La
i Y/
S

When you select a small-sized bar (i.e. corresponding to a logical disk) the Explorer Bar will display information on it as
well. The page title will contain a drive letter, which is assigned to the disk. The disk layout graph will be colored in
accordance with the volume ratio of the used space to the free space (the light colored sector). The table on the right
will contain the following information:

e Volume label (if available),

e Type of the logical disk,

e File system (represented by the color of the graph and the selected bar),
e Total size, used space and free space (in GB or MB).

Below there is a list of wizards, which may be called for this disk. All default values of parameters will correspond to the
disk settings.

Partition Management

In this chapter you will find all the information necessary to carry out partitioning operations supported by the program.

Basic Partitioning Operations

Here you can learn how to accomplish basic partitioning operations (create, format, delete).

Creating Partitions

The program provides the ability to create a new partition within a block of un-partitioned space.
Restrictions
1. Do not use the Create Partition function in order to undelete the last deleted partition.

2. The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert a free
space on an existing partition to a new partition.

3. The program cannot create new partitions on Dynamic Disks.
Dialog Startup

1. Select a block of free space on the Disk Map;
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2. Select in the Main Menu: Partition > Create Partition.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Dialog Setup

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Yes
button to confirm the operation.

[ ]
Are you sure you wanlt lo create a new parlition on disk 37

You are about to create a new parition in (Unallocated). 19.9 GB arca. Flease select size.
position and file sysiem of the new partition.

Basic Hard Disk 3 (VMware, VMwane Virtual 5 5C51 sk Dev)

I I 1) New Volume (H:) I
19.9GE NTFS

Create new partiion s Prmasy patton [

Flease spacify new partibon size 20479 - TMB-20473 MB

Please speciy size of free space befors the parition: 0 * OMB - 20,465 MB

Please specify size of free space afterthe patition: 0 % OMB-20472 ME

Flease sedact file system for new partition: | NTFS El

Flease snter new volume label: Naw Voluma

Flaasa spacify dive letter H E|

%) [More options | Yes ] l Mo |

o Define whether the partition will be Primary, Extended or Logical. You can choose the desired partition type
from the pull-down list. As a matter of fact, the available alternatives fundamentally depend on the selected
block of free space - within the Logical free space, only Logical partitions can be created; Within the Primary free
space, both Primary partitions or the Extended Partition can be created.

e Partition Size. Define the size (in Mb) of the new partition.

o Free space before. Define the position (in Mb) of the new partition relative to the beginning of the block of free
space.

o Free space after. Define the amount of trailing free space (in Mb) at the end of the new partition.

Partition size and position may also be defined by using the drag-and-drop technique. To do
that, just carry out the required operation on the Disk Map. The virtual operations are to be
available.

=

e File system for new partition. From the pull-down list select a file system the newly created partition will be
formatted to, otherwise the partition will remain unformatted (so that it will not be ready to use).
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o Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually

used for drive identification.

e Drive letter assignment. The pull-down list contains vacant drive letters that can be associated with the newly
formatted partition.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases).
To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on
the chosen file system, the following options become available:

| Usa 05 busk in format routine
Flease select number of sectors per cluster: | 8 [=]
Please selact number of sectons per boot

Plaase salact number of root entries
l‘HﬂStQﬂ:: defaults
e Use OS built-in routine. Mark the option to restrict the available values according to the used OS.

o Whether the surface test will be performed. Define the level of the surface check to make the program find bad
and unstable sectors and mark them unusable in the file system metadata.

o The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set
the number of sectors to be reserved for the boot area on the partition with this spinner control.

o The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum
amount of files/directories to be placed in the Root Directory on the FAT16 partition.

e The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control.

.A Number of available options depends on the selected file system type.

Result

After the operation is completed you receive a fully functional partition.

Formatting Partitions

Any partition should contain some file system to be used for keeping data. The process of installing a file system is
commonly known as formatting. A huge variety of file systems have been developed these days.

Supported File Systems
The program provides the ability to format partitions of the following file systems:
- FAT12 & FAT16
- FAT32
- HFS+
- NTFS
- Ext2
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- Ext3
- Ext4

- Linux Swap v. 2
Dialog Startup
1. Select a partition on the Disk Map;

2. Select in the Main Menu: Partition > Format Partition.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Dialog Setup

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Format
button to confirm the operation.

]

- * Are you sure you want to format volume (F:)?

You are about to format volume (F:) [No label]. NTFS. Your computer may
no Jonger boot or work comectly

Please select new fie system:  [ZNECNNNN )
Please enter new volume label; | New Volume

¥) More options l Foemat ! | No

e File system. From the pull-down list select the desired file system type. In fact, the program displays only those
file systems that can correctly be placed to the selected partition, taking its capacity into account.

e Volume label. Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually

used for drive identification.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases).
To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on
the chosen file system, the following options become available:

7] Use 05 buik in fermat routing

Please selact number of sectors per cluster: | 128 [+]

Please select mumber of sectors per boot:

Plaasa salact number of oot entries:
Restore defauls |

e Use OS built-in routine. Mark the checkbox to restrict the available values according to the used OS.

o  Whether the surface test will be performed. Define the level of the surface check to make the program find bad
and unstable sectors and mark them unusable in the file system metadata.
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o The amount of sectors per boot. This parameter is available exclusively for FAT16 and FAT32 file systems. Set
the number of sectors to be reserved for the boot area on the partition with this spinner control.

e The amount of root entries. This parameter is available exclusively for FAT16 file system. Set the maximum
amount of files/directories to be placed in the Root Directory on the FAT16 partition.

e The amount of sectors per cluster. Define the Cluster Size for the formatted partition with this spinner control.

A Number of available options depends on the selected file system type.
?

Result

After the operation is completed you receive a fully functional partition formatted to the specified file system.
Deleting Partitions

Dialog Startup

In order to start the operation you should take the following steps:
1. Select a partition on the Disk Map;

2. Select in the Main Menu: Partition > Delete Partition.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Dialog Setup

Initially the program suggests you just to remove references to the selected partition from the Partition Table.

7 e
W7, Are you sure you want to delete volume (F:)?

w You are about to delete volume (F:) [No label]. NTFS. Your computer may
no longer boot or work comactly

v ‘Dom(asi{vd‘une!abdnentmg

e Enter the volume label to confirm deleting. To confirm deletion of the selected partition, enter its Volume
Label. The current volume label is displayed above.

e Do not ask volume label next time. Mark the option to inhibit confirmation next time you start the dialog.

To additionally destroy the on-partition data, click the More options button at the foot of the dialog page, so you will be
able to define:
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V| Also wipe partition data

Please select the byte mask to wipe out the data with
HEX value: 00
ASCll valve: 20

Please specfy the number of wiping passes
1

Vedfy wipe results

1. Wiping wil destroy all data wehout any possbilty to restore!
e Select the byte mask.... The HEX value spinner control enables to set a two-figure hexadecimal character value
("00" by default). The available range is from "00" to "FF". It is synchronized with the ASCII value.

e Specify the number of wiping passes. You can choose a number of passes for the wiping pattern.

e Verify wipe results. You can also choose whether to carry out residual data verification or not specifying the
percentage of sectors to check.
Result

By default, the operation takes only a fraction of a second. However, the program waits until Windows completes the
modification of the disk layout.

Hard Disk Management

In this chapter you will find all the information necessary to carry hard disk operations supported by the program.

Updating MBR

The program enables to overwrite the current bootable code in the MBR (Master Boot Record) by the standard
bootstrap code. This can help to repair a corrupted bootable code of a hard disk resulted from a boot virus attack or a
malfunction of boot management software.

In order to update MBR of a hard disk you should take the following steps:
1. Select a hard disk on the Disk Map.
2. Select in the Main Menu: Hard Disk > Update MBR.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

o e

1 Are you sure you want to update master boot record?
—— Curmrent MBR contents for hard disk number 0 will be lost after this operation. Your

computer may no longer boot comectly
i Yes l | No

3. The operation will be performed immediately after confirmation.
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Wipe Tasks

In this chapter you will find all the information necessary to wipe a hard disk/partition of any file system or only destroy
any remnants of deleted files/directories left on disk without affecting the used data, thus providing high level of
security.

The operation can be accomplished with the Wipe Wizard or corresponding dialogs.
Wizard Startup

e |n the Main Menu: select Wizards > Wipe Hard Disk or Partition...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Wizard Setup

The wizard offers the following steps to accomplish the operation:

¢ The hard disk/partition to wipe. Select a hard disk/partition the data of which you want to destroy.

'Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)
I ©) Local Disk (C:) . ©) data (Z:)

282.3GB NTFS 217GB NTFS

Basic Hard Disk 1 (VMware, VMware Virtual S SCSI Disk Dev)

I ©) Local Disk (%)
493.5 GB NTFS

Basic GPT Hard Disk 2 (VMware, VMware Virtual S SCSI Disk Dev)

I l ©) (Unallocated)
569.8 GB

e Wipe mode. This section enables to switch between two options:

O | Wipe out 3l the data

Choose this option £ you want 1o destroy completely all the data on the selected object

Choose this option £ you want 10 destroy the traces of data that may have been left after an ordinary delete
operation

- Wipe out all data. Select the option to irreversibly destroy all on-disk data of the selected object.

- Clear (wipe) free space. Select the option to destroy any remnants of deleted files/directories left on disk
without affecting the used data.

e The Clear Free Space operation is available only for Logical and Primary partitions of known
file systems.
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e Wipe method. Here you can select a specific data erasure algorithm or create a customized method by marking
the appropriate option.

@ | Specfic algomthm

US DoD 5220.22-M ~

You can see the algosthm descnption and st the laval of vedfication on the naxt page

Create your own Data Santization method
You can creata your own Data Santtization method

- In case you preferred to use a specific algorithm, the next page of the wizard enables to get detailed
information on the selected algorithm, choose whether to carry out residual data verification or not specifying
the percentage of sectors to check and estimate the time required to accomplish the operation.

Wipa mathod

US DoD 5220.22-M

Orverarite all addressable locations with a character, s complement, then a random character and verfy

Erase passes court: 3
erfy passes count: 1
| | Verdfy wipe results |
srcantage of sacion to check: | 100

FApprocimate wips time: 14:02:40

."'.'\I You can skip vanfying complataly or partly by disabling # or mducing paraniages of sactors to chack
[ 1-/

\ Flegse note. & would be a devistion from US DelD 5220.22-M

M

.A The list of supported military and government standards may vary for your product.

- In case you preferred to create a customized algorithm, the next page of the wizard enables to define up to 4
wiping patterns, number of passes for each wiping pattern and for the group of patterns. The Mask spinner
control allows you to set a two-figure hexadecimal character value ("00" by default). The available range is from
"00" to "FF". You can also choose whether to carry out residual data verification or not specifying the
percentage of sectors to check.

Wipe pacameters

Mask: (0() & Passcount: 1 A
Mask Pass coun

Mask Pass cous

Mask Pass count

Pass count for the group of pattems

Verfy wipa rasults

e Revise your changes. This page informs on all the actions to be made in the wizard in a bright, graphical form.
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Your hard disk before the changes
Basic Hard Disk 0 (VMware, VMware Virlual 5 SCS1 Disk Dev)

) Local Disk (C:) deaaf&]

LElL e NIFS 7 GENTES

Your hard disk sfher the changes

. Basic Hard Disk 0 (VMware, VMware Virdual 5 5C51 Disk Dev)

©) (Unallocated)
£99 9 GB

Wizard Result

After the operation is completed you can see a well informative summary page, providing structurally divided in-depth
information on all the actions made in the wizard.

Report| | Disk Viewer

SC ParaGgcon

$O"WA|( GROUP

Data Sanitization Report

Customer Information

Person: Windows User
Company:

Report Information

Report Date: Thu 16 December 2010 06:38:03 am
Version: Paragon Hard Disk Manager™, version 10.0.15.12617(16.12.10)

Svstem Information v
Save | Prrt ’j

The program also enables to store the resulted report. To do that, just press the Save button and choose the exact
location in the opened dialog.

To make sure that all on-disk data is irreversibly destroyed call the Disk Viewer dialog by clicking the appropriate tab and
see it for yourself.

Copyright© 1994-2011 Paragon Software Group. All rights reserved.



44

L=
=

[ 0x0000 (Do D1 SC C7|S5F C1 B DA 6A D7 5C 5B E3 32 BC 3A
| 00010 |94 06 &6 76 9D 16 &l OF CE &9 2A F7? OF 2F 12 EB
| Dx0020 |73 &1 &F 19 &4 DB 14 7D D6 &5 03 08 DI 58 24 EA
| 020030 |32 B6 32 3C |75 SF D3 C2 FC &6 OF B3 C4 Cl1 CB E7
| Dx0040 | 2D OF D3 99 BF 64 F3 85 0OC 31 D4 VE BE SA 8A 87
| 0x0050 |13 EB E3 B4 Bl 9C 15 S8/|72 A2 37 75 9E 08 DF A9
| 0x0060 (CF BY 52 FB 93 A9 DE 8C 9D 9B BB 80 BO 81 70 44
| 0xD0O70 |C2 YD 70 19 75 20 ES ED 26 E2 29 A7 &D &2 7B 46
| 0x0080 |77 10 &6 EC F5 E9 59 7F 87 &d &0 20 4F 2C 56 C4
| 0x0090 |F? EF C4 &6 CF AC 76 18 BF 24 18 0C 9C CD &2 D1
| 0x00AD | OF &6 SA 9C 8E 75 11 75 05 0D DF 1D 9F A2 F1 AD
| 0x00B0 | BD S6 SF 79 79 DA C3 OF 38 C5 43 CB 97 B2 F2 4D
| Dx00DCD | 9E A4 EG 13 83 39 1F OA 51 Db 49 F4 4B 72 A6 D2
| 0=00D0 |62 4B CE 5C | 3F FA DD E2 D4 %9 58 CB CF 4E 8C AE
| 0x00EQD | A4 OB 62 F7 |19 47 E4 7B 01 E4 DS 19 4D SC DC 34
| DxDOFD | &6F 3A Ef 57 62 71 14 65 87 S5E 75 AE 21 AB A9 BA
| 0x0100 (B? 7E ED 79 /11 14 FD 20 98 BB ES 61 &E C7 C1 28
|Dx0110 DD 07 72 &B AD A2 AC 35 9D 25 CE B4 3E 45 FF EBE
| 0x0120 |51 07 6B DB |02 D2 BS CE 82 56 53 C0 95 84 CF 3E
| 0x0130 |45 4E 07 3E &S5 99 AF 81 C7 &2 CB DE SE 4C Ce 29
| Dx0140 (1B 18 EE 1B 45 46 91 %4 E6 B4 DA 79 7C AD 7D 1E
| 020150 |99 74 C1 E3 05 74 SBE 6D 68 SD Ba 5D %A F3 8F 66 .z
| 0x0160 (8B C4 7D 7B 18 &3 DE &2 B4 B7 F9 E4 DE 21 F6 DC

| 0x0170 (0D C9 D1 F2|DE 12 9F Be &6 B3 CB F3 &A 2C BC 40

|«

A g
[T -
o B

TR
g e
e -

el M-
O Qe omZe 1 & <l

e e
[t ol = L s RS
(1]

H-
-

[ B B W o R
M- =- - 2--- mEpaz-
et e . EH R T ]
- wHmEg g S -
(=T L TR R - RSP
= Dew Coo
1

Pleass selact sector number

¢
t
@)
i
@
R

.A The Summary page will be available only when the Virtual operations are disabled.

Available operation scenarios:

e Hard Disk Utilization

Task Scheduling

Automation of operations can really help you out when you’ve got to accomplish certain routine operations on a regular
basis as it enables to execute them without your involvement while optimizing your computer’s work-load.

Setting a Timetable

Thanks to the embedded Scheduler, you can set a timetable for execution of any operation. It has two categories for
time settings (these correspond to appropriate items in the Schedule type menu):

e Initiating the operation by an event:
- One time only (i.e. the Once item)
- When the system starts (i.e. the At System Startup item)
- When the user logs on (i.e. the At Logon item).

¢ Initiating the operation periodically (i.e. Daily, Weekly, Monthly).

Please specfy how and when would you like to pedform the task
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You need to select one of the variants. Depending on your choice, the scheduler displays a form that enables to set a
timetable.

Fleasa spacify how and when would you Boe to perdomn the task

Shutdown system after backup
| Generate unique names for scheduled bacloups
Fun the task on

09/02/2009 = at | 1200 AM =

Every
1 * weskiz) on 7| Monday Fricany
Tuesday Satunday
Wedneaday Sunday
Thursday

Do not run the task after:

specily yser name and password

To run the task in the log-off mode, please specify administering login info by following the
f appropriate link in the left lower corner of the page.

The Shutdown System on Complete option enables to automatically switch off the
computer on the successful accomplishment of the operation.

Managing Tasks

All scheduled tasks are placed in a separate list, which can be retrieved by clicking the Scheduled Tasks tab in the
Explorer Bar:

Disk View | Scheduled Tasks | Archives |Hu|p
Scheduled Tasks =) [& [k

Mame Script Yhen to Fun
| Backup of MBR of hard disk 0 scr_020909124744450pal At 1.2:00:00 AM every Man, of every weel, starting 3/2/2009

On every task you can get in-depth information, including:
e The task name
e The full path to the generated script of the task
e Scheduled time of launch
e Statistics on the last launch
e Scheduled time of the next launch
e Used account information
e Comments to the task

To easily manage tasks, the program enables to arrange them according to a certain characteristic just by clicking on the
required property.
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c This feature can be particularly beneficial when the Scheduled Tasks list contains too many
items.

You can also enable/disable, rename, delete, refresh or modify properties of the selected task.

Task Editor

With the Task Editor you can easily modify properties of scheduled tasks. To do that, you should take the following
steps:

1. Select a task on the Scheduled Tasks list.

2. Click the Properties button on the Scheduled Tasks list.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

"%, Task Properties: Backup of MBR of hard disk0 e
General| | Schedule
O Program; |C’\Program Flles'Paragon Softwane'\Deve Backup 10 Server Edtion'program’scnipts exe
| Seript n Files/Parsgon Software/Drive Backup 10 Server BEdtion/scripts/scr_020909124744450 psl
[ Edt. |[ Bowse. |

Comenents Backup has been scheduled: 3/2/2009 5:47-44 AM

| Enablsd

[ ok ][ ey |[ Conce

3. Inthe opened dialog window you can see two tabs - General and Schedule. Click the General tab to modify:
e Full path to the macro-command program-interpreter, which describes the scheduled task;
e Command line for starting the interpreter (i.e. the task described in macro-language)
e Comments referring to the task
e The option of enabling/disabling the task.
By clicking the Schedule tab you can modify the task timetable.
In order to apply the changes, you need to click the Apply button at the foot of the dialog.
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Creating a Scheduled Task

You can set a timetable for execution of any operation. For backup and copy operations the program offers handy
wizards, while all the others can be scheduled with the Save to Scheduler dialog.

To create a scheduled task you should take the following steps:

1. Make sure the virtual mode of execution is enabled;

2. Carry out with the program all operations you need to schedule;

3. Call the Save to Scheduler dialog in the Main Menu: Tools > Save to Scheduler...;

N =)

@ Schedule virtual operations?

Al vitual operations you have made will be saved to the scheduler. No operations will be
apped

Task name: | Scheduled Task
Please specify how and when would you like to peform the task
Shutdown system after camying out the tasks

Run the task on

05/02/2009 5 at | 1200 AM
Every

1 * dayls)

Do not run the task after.

- n : & WY

Discard all operations on close I Yes I No

4. Inthe opened dialog enter the required task name and specify the task timetable;

5. The operation will be performed immediately after confirmation.

A This command is unavailable if there are no operations on the List of Pending Operations.

Scripting

The program actions can also be represented in form of a script. The script describes the appropriate operation with
macro-language commands. There is an interpreter utility - SCRIPTS.exe, which is included in the program installation
package. This utility works in the unattended mode, which enables to automate operations.

Startup

You have no need to write a script since the program has a convenient interface for such a task. In order to generate a
script on the base of the entered parameters of the required operation, you should take the following steps:

1. Make sure the virtual mode of execution is enabled;
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2. Carry out with the program all operations you need to be scripted;
3. Call the Generate Script dialog in the Main Menu: Tools > Generate Script....

Setup

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Generate
button to confirm the operation.

RN ===
rji Generale scripl?
<

All wirtual cperations you have made will be written to the script. No operations
wil be appled.

Please spaciy & name for the task seript file
script_020805_125123443 psl

o Addto Task List

%) [More options Generate ]

e Script file name and location. By default, the program offers to add the script to the Task List with a name

containing its creation date and time. Unmark the Add to Task List checkbox to define an exact location and a

filename for the script file. The default file extension that is reserved for scripting files is .psl, which however can
be modified.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases).

To activate the advance mode, you need to click the More options button at the foot of the dialog page, so you will be
able to define:

Please select script generation options
Alow to interact with the user

Tum this option off # you do not want to get confirmation dialogs when the script is
beng camied out

V| Commi after each operation

Tum this option on to ensure the changes will be committed after each operation
V| Check for emors after each operation

Tum this option on to make script interpreter to check the result of each operation
Discard all operations on close

Tum this option on to discard all the pending operations after generating the script

e Interaction with the user. Mark the option to pause the script interpreter during the execution to prompt the

user’s confirmation or other input. Otherwise the program will not stop using default values for parameters if
needed.

Commit after each operation. Mark the option to commit changes after each operation.

Check for errors after each operation. Mark the option to insert a special code in script, which checks the status
of the last executed operation and stops the script processing if there are errors of any kind.

Discard all operations on close. Mark the option to empty the List of Pending Operations after generating the
script.

Result

After the operation is completed you receive a new script file. It is placed into the specified destination, its features
defined in the dialog.
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f This command is unavailable if there are no operations on the List of Pending Operations.

To learn more about scripts please consult the Paragon Scripting Language manual.

Extra Functionality

This chapter describes the supplementary functionality available in the program.

View Partition/Hard Disk Properties

The program enables to obtain in-depth information on the properties of hard disks and partitions. Besides the general
information, such as capacity, used space or file system type it provides the possibility to get info on hard disk geometry,
cluster size, exact partition location, etc.

To get properties on a partition/hard disk, please do the following:
1. Choose a partition/hard disk on the Disk Map.

2. Select in the Main Menu: Partition/Hard Disk > Properties...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

General| | Fie System Info l Advanced

Local Disk (C:)

Volume: label: [No lsbel]
File system: NTFS
Type: Prmary
Capacity: 43533GB
536.868,814.848 Bytes
1.048 571,904 Sectors
Used by data: 53GB(1%)
10,016,497 664 Bytes
19,563,472 Sactors
Free space: 4306GB (39%)
526.852,317,184 Bytes
1.029.008,432 Sectors

In the opened dialog information will be grouped according to its properties, thus by clicking tabs you can get
information you need.
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File Transfer Wizard

File Transfer Wizard is designed to make such operations as copying of separate files/directories or burning of them to
CD/DVD as easy and convenient as possible. It may be of particular use in case of a system malfunction, caused either by
a virus attack or files corruption, in order to get the system back on track again. Besides it provides access to Paragon
backups as regular folders to browse through their contents or copy required files.

Startup

e Select in the Main Menu: Tools > File Transfer Wizard.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Setup
The wizard offers the following steps to accomplish the transfer operation:

e Place to look for files/directories. Select a source disk from the pull-down list in the left pane of the page. The
program enables to process both mounted and unmounted (without drive letter assigned) partitions. Besides it
is possible to map a network drive.

Source

5] Local Disk () | ‘} o X ¥

N (S DVD RW Deive (D) s
[5] Local Disk E) B
[5] Local Disk F)
[5] Archives G)
(5] New Volume (H)) S
@) Physical panttions

., NEW VOLUME, Disk 1
1] Network places 9

Cl] Network -

e Object(s) of operation. Choose files/directories you want to copy and place them to Clipboard by pressing the
Add button. To delete a file/directory from the Clipboard, select it in the Clipboard pane and press the Remove
button. You can also create a new folder, rename or irreversibly delete existing files/directories of the left pane
by pressing the appropriate buttons.

Clipboard Source
Name  Souce Path 5] Local Disk (F) v @R €
images F/images/ '
'Name -
T TG By
%, hibedil sys
) %, pagefie sys
» [35] somecmd emd
# (8)DVD RW Drive (D)
- ; | Loca Disk (E)
=] Local Disk (F?) -

l—

3 System Volume Information
Total data size: 132.8 KB
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A Files/directories deleted from the Clipboard remain intact on source disks.

e Destination to store the object(s). The File Transfer Wizard allows copying data to local or network drives, to
physical partitions (without drive letters assigned), or burning them to CD/DVDs. Choose the way the data will
be stored.

There are several ways the Wizand can store your data. Plese select how would you ke to save the: data:
@) | Save data to local network drives. |

Save data to physical pariiions
Bum the data te CD or DVD

e Revision of changes. The Transfer Summary page provides structurally divided information on all the actions
made in the wizard. Check the changes and come back to any step of the wizard (if necessary) by following the

required hyperlink.
Please overview the transfer options. You can retum to the comesponding page and change the options by cicking on tithe
hypedinks

Obiacts to transfer
Object(s) selected: 1
Total data size: 132.8 KB (136,024 Bytes)

Transfer destination
Destination path: C/
Space available on destination: 4906 GB (526.821.834 752 Bytes)
Overwrite existing files: No
Result
After the operation is completed the required data will be placed into the specified destination.
Available operation scenarios:

e Copying of data from the corrupted system disk to another hard disk

e Burning of data from the corrupted system disk to CD/DVD

Mount Partition

The program enables to assign or remove drive letters of existing formatted partitions.

Assign Drive Letter
In order to mount a partition you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main Menu: Partition > Assign Drive Letter...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. Specify a drive letter for the selected partition. Initially the program suggests some consistent value for this
parameter. So you may just press the Yes button to confirm the operation.
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\ Assign a drive letter?

L This allows access to the volume by using the drive letter assigned. The
assignment is not recommended f the volume contains a file system not
supported by your operating system

Assign the folowing drve letter: NN ~ |

However you can manually define the required letter by selecting it from the pull-down list of available drive
letters.

4. The operation will be performed immediately after confirmation.

Remove Drive Letter
In order to un-mount a partition you should take the following steps:
1. Select a partition on the Disk Map.

2. Select in the Main Menu: Partition > Remove Drive Letter.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. The operation will be performed immediately after confirmation.

Modifying drive letter of the system partition will result in inability to boot the operating

f system.
After having processed partitions with installed software, some programs may not run
properly.

Test Surface

The program enables to test surface of existing partitions and blocks of free space for bad or unstable sectors. If found
any it automatically marks them unusable in the file system metadata, thus minimizing the risk of data loss.

In order to start the surface test you should take the following steps:
1. Select a partition or a block of free space on the Disk Map.

2. Select in the Main Menu: Partition > Test Surface...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

3. From the pull-down list choose the level of the surface check.
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L8 [t
@ Test surface of volume (C:)?
Testing volume surface allows 1o find bad blocks and other peoblems
Please select 3 suface test level m;
| Yes ‘ No

4. The operation will be performed immediately after confirmation.

Check File System Integrity

The program allows you to check integrity of a file system. It can be used to detect possible file system errors before
performing any operation on a partition.

To start the system integrity check you should take the following steps:
1. Select a partition on the Disk Map.
2. Select in the Main Menu: Partition > Check File System Integrity

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

-9 s
@\ Check volume (C:) [No label]. NTFS for emrors?

1 Please note that check operation needs exclusive access to the volume. You may be
asked to restart your computer to complete the operation

[ Yes |

3. The operation will be performed immediately after confirmation.

Check Recovery Discs

You've got the ability to check whether bootable media created with the program is 100 percent error-free and ready to
use. The Check Recovery Disc Wizard will help you do that.

Startup

e Inthe Main Menu: select Tools > Check Recovery Discs...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

Startup

The wizard offers the following steps to accomplish the operation:

e CD/DVD drive. Select from the pull-down list of available CD/DVD devices the required drive to use during the
operation.
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Dxive: | Optiarc DVD RW AD-T1704A 3
Eect the disc after check

e Set whether to eject the disk after the operation is completed or not.

Result

After the operation is completed you can see results of the check.

Edit/View Sectors

With the built-in Edit/View Sectors tool the program enables to view/edit sectors on existing partitions/hard disks
providing the possibility to directly access and modify sectors, save and restore sectors from specified files, navigate

through the system metadata, etc.

In order to edit/view sectors of a hard disk/partition you should take the following steps:
1. Select a hard disk/partition on the Disk Map.
2. Select in the Main Menu: Partition/Hard Disk > Edit/View Sectors.

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.
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A Careless use of the Edit Sectors function may result in the irreversible data corruption.

Send Log Files

The program enables to simplify the procedure of sending support requests to the Paragon Support Team. In case of
having difficulties with handling the program, you, with the help of this very function, can address the company support
engineers and provide them with all the information they need such as the disk layout, performed operations, etc. in
order to tackle the encountered problem. Information of that kind is stored in Log files.

In order to send log files to the Paragon Support Team you should take the following steps:

1. Callthe Send Log Files dialog in the Main Menu: Tools > Send Log Files;

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

2. Provide a customer name and a product serial number;
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3. Give a detailed description on the encountered problem.

Send log files

/; Send log files.
" Please enter short description of your problem and send log fles bo support

Customer Name
John Smith
Serial Mumber
(% de-654ac-a4%c-Tdaf §-237a2|
Conbent of inguiry
Help!

By clicking the Send button the built-in mail client will generate a template request with attached compressed log files
and then send it to the Paragon Support Team.

Log Files

Log files are simple textual files that can be opened by any text editor. There are several log files automatically
generated by the program:

Stubact.log Contains in-depth information on parameters and performance of all operations
carried out by the program

Pwlog.txt Besides brief overview on operations it also contains detailed information about the
state of all hard disks®

Cdb.log Contains low-level information on the CD/DVD devices used in the system

BioNTlog.txt It is an OS-dependent supplementary log file derived from Bioxx.dll. It may contain
valuable information on Windows family operating systems

Log files do not contain any confidential information on the operating system settings or
the user documents.

A The Send Log Files function is only available when outgoing mail server (SMTP) and the user
e-mail address are properly set. To learn more about it please consult the Settings
Overview chapter.

View Logs

With a handy dialog you can study logs on any operation carried by the program. To make this job as easy as possible, all
the information is structurally divided, besides there is the possibility to see the disk layout before and after an
operation, what is very convenient.

In order to view logs on carried out operations select in the Main Menu: Tools > View Log Files
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Started 9702009 at 12-40:12 AM. Firished at 12:40:29..
Started 9732009 at 12-40045 AM. Finished at 12:41:21...
Started 9732009 at 12-42:11 AM. Freshed at 12:4429
Started 3732009 at 12-45:04 AM. Firished at 12:45:12...
& Started 9°3/2009 at 12-45:19 AM. Freshed at 1:28:51
& Started 3722009 at 31740 AM. Finished at 3:21:28 AM N operations have besan found for the sslected session.
& Started 922009 at 3:30:36 AM. Finished at 3:41:04 AM
# Started 3722009 at 3:41:05 AM
& Started 922009 at 12-15:48 PM. Freshed at 12:20:26...
& Started 3722009 at 12-20-26 PM. Frished at 12:24:46..
# Started 922009 at 12:24:456 FM
# Sared 922009 at 12-06:15 PM. Freshed at 12:0747...
& Stared 922009 at 12-07:47 PM. Frished at 12:21:18...
¥ Stated 3722009 at 12-27:18 PM. Fnished at 12.30:15...
Started 97272009 at 1230015 PM. Finished at 12.31:33..
Sarted 37272009 at 12-31:33 PM. Finished at 12:41:47...
Started 9722009 at 12-44:44 PM. Finished at 12.58:38...
#- Started 3722009 at 1:08:03 FM

Cisk System Configuration Bafore Season Cisk: System Configuration After Session
Basic Hard Disk 0 (Viware, Viware Vidual 5 SC51 Disk Dey) - OF Basic Hard Disk 0 (Viware, Viware Virdual 5 SC51 Disk Dev) - OF
@ (C) @ (C)
NTF5 NTFS

Basic Hard Disk 1 (Viware, Viware Villual 5 SC51 Diske Dey) - OF Basic Hard Disk 1 (Viware, Viware Vidual 5 SC51 Diske Dev) - OF

P  P—
FREE FREE

Basic Hard Disk 2 (ViMware, Viware Vidual 5 SCS1 Diske Devy) - OF Basic Hard Disk 2 (ViMware, Viware Vidual 5 SCS51 Diske Dev) - OF

 [h— o —
FREE FREE

Typical Scenarios

This chapter lists a number of the most frequently used scenarios that may be accomplished with the program. You can
find here useful recommendations and descriptions of operations.

Recovery Scenarios

Fixing MBR after a boot virus attack

Let’s assume that the MBR (Master Boot Record) of your hard disk has been corrupted as a result of a boot virus attack,
thus your system fails to boot.

To fix the MBR of your hard disk, please do the following:

1. Start up the computer from our Linux/DOS wiping media.

Wiping Media Builder can help you prepare our environment either on a CD/DVD disc or a

f thumb drive.
To automatically boot from the wiping media please make sure the on-board BIOS is set up
to boot from CD/USB first.
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2. Inthe boot menu select Normal Mode to use the Linux environment (more preferable) or Safe Mode to use the
PTS DOS environment (in case you’'ve got problems with Linux). Moreover you’ve got the option to boot into the
Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware incompatibility. In this case,
only the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This mode has
simple graphics and a simple menu.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Inthe Linux launch menu select Boot Corrector. You can find it in PTS DOS as well.

4. On the Wizard's Welcome page, select the Correct the Master Boot Record (MBR) option.

Flease choo e the operation

() search for Windows installations 1o correct
(®) Correct the Master Boot Record (MBR)

() Correct the partition beot record

) madify paniion parameters

() Correct boot paramessrs (bost.ini, BCD)

To begin, click Next

5. On the next page choose the required hard disk from the pull-down list (if several) and then select the Update
the MBR executable code option.

Please choose the hard disk o correct boot problems

A

Flease pointout the operation o perdorm:

) view the MER
(& Updare the MER executable code

) Reorder primary panitions (change sk1s)

6. Confirm the operation.

“ Updae the MBR executable code of the Basic Disk 0 (40.0 Gb)7

50 =

7. After the operation is completed click the Report button to see a well informative summary page. The program
also enables to store the resulted report. To do that, just press the Save button and choose the exact location in
the opened dialog.
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h Reporting

"4 You have successfully completed boot correction. To view the repan
on the operations pedormed, click Report.

Report

Paragon Bool Correcior's Repon
Operations perdormed:

Operation #1: Correct the Master Boot Record
Hard disk targeted: Basic Disk 0

Status: Successlul

Date and Time: 2009 Jan 14 Wed 140109

8. Click the Finish button to close Boot Corrector.

9. Reboot the computer.

Correcting BCD (Boot Configuration Data)
To automatically correct Windows BCD, please do the following:

1. Start up the computer from our WinPE wiping media.

Wiping Media Builder can help you prepare our environment either on a CD/DVD disc or a

f thumb drive.
To automatically boot from the wiping media please make sure the on-board BIOS is set up
to boot from CD/USB first.

2. Launch Boot Corrector.
3. Onthe Wizard's Welcome page, click the Next button.

4. Select Correct boot parameters... to let the wizard fix BCD in all found Windows installations.

Windows installation to comect
View the st of all windows installations and comect boot parameters

Cormrect the Master Boot Record (MBR)
View the st of all Hard Disks and corect MBR executable code on some of them

Edit/View Sectors
View, edt, backup and restore sectors or a group of sectors on the hard disk or parition of your
choice

Comect boot parameters (boot ini, BCD)

5. The wizard will ask you to confirm the operation. Apply the changes to complete.
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' The wizard has not apphed the changes yet. On this page you can etther accept or reconsider the
= changes

Note: ¥ you accept the changes. the wizard wil physically perform all operations. You won! be able to
interrupt this process or undo the changes.

k may take some time to apply the changes. You may also be asked o restart your computer during this
process.

Would you ke to apply the changes?

After completing the operation close the wizard, and then reboot the computer.

Fixing Windows startup ability

Let’s assume that due to an unknown reason your Windows fails to complete the startup procedure. At first everything
seems quite OK, you can see the standard startup messages on the screen, but at some moment it hangs up.

To fix your Windows startup ability, please do the following:

1. Start up the computer from our Linux/DOS wiping media.

Wiping Media Builder can help you prepare our environment either on a CD/DVD disc or a

2 thumb drive.
To automatically boot from the wiping media please make sure the on-board BIOS is set up
to boot from CD/USB first.

2. Inthe boot menu select Normal Mode to use the Linux environment (more preferable) or Safe Mode to use the
PTS DOS environment (in case you’ve got problems with Linux). Moreover you’ve got the option to boot into the
Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware incompatibility. In this case,
only the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This mode has
simple graphics and a simple menu.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Inthe Linux launch menu select Boot Corrector. You can find it in PTS DOS as well.

4. On the Wizard's Welcome page, select the Search for Windows installations to correct option.

Please choose the aperation

(&) search for Windaws installations i cormect
3 Correct the Masier Boot Recard (MBR)

':: Carrecl the panition baat recond

() Modify partition parameters

(Z} Correct boot parameters (boovini, BCD)

To begin, click Mext

5. On the next page choose the required Windows installation from the list of found installations (if several), then
select the Edit the Boot.ini file option. If you’re not sure which installation you need, please use the Properties
button to get more info on the selected item.
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Correct Windows installations

Pragram has searched for valid Windows installations on your
computer. The resuls of the search you can see below, Stalus S refer
1 4 syskem partition (you can edit the Bootini file), B - a boot panition
{you can correct the System Registry).

N |Partiton |Status [Sysem mor  [Type
1  Disk0, Parition 0 5+B  WINDOWS WinxpP

Far the highlighted Windows installation, please
point out the operation W perdorm:

) Correct drive letiers in the System Registry
(%) Edit the Boot.ini file
) Correctihe partition oot record

Adjust 05 o oot on new hardwane

Tao continue, click Mext

6. Examine the file — maybe that’s where the problem is. If it contains a mistake, correct it by using the appropriate
buttons.

Edit the Boot.ini file on Hard Disk 0, Partition 0

[boat laader]

fimeout=10
defauh=muli(0kdisk(0irdisk(Dip artition{ IWNDOWS.

[operating systems)

miula(0idi sk (0irdisk (0 panitisn( INWINDOWS ="Paragan VMWare Windows XP Partition 017 fasudewsct 1

oo ] [ msex ][ s | (_veee |

I Edin ] |_ Insert the sample [l Add the sample ]

7. If the Boot.ini file does not contain any mistake, please return to the Correct Windows Installations page to
correct drive letters in the Windows System Registry.

Correct Windows installations

Program has searched for valid Windows installations on your
computer. The results of the search you can see below, Status S refiers
1o & sysiem panition (you can edit the Boot.ini file), B - a boot panition
(you can correct the System Regisiry).

|[N |Panition |staws [Sysem oot [Type
1 Disk D, Partition 0 S5+B  WINDOWS WinxpP

For the highlighted Windows installation, please

paint gut the operation o perform:
(&) Correctdrive leniers in the System Registry
) Edit the Boovini file
(} Correct the partition boot record

Adjust 05 o boot on new handware

To continue, click Rext,

Copyright© 1994-2011 Paragon Software Group. All rights reserved.



62

8. On the next page choose a hard disk from the pull-down list (if several), then the required partition. If you’re not
sure which installation you need, please use the Properties button to get more info on the selected item.

Pamitions Lis1 Leters Map

Below you can choose a hard disk drive and see all panitions on it Information about drive letiers
assigned 1o these panitions 15 taken from the Sysiem Regisiry of the Windows installation selecied,

[[Basi Disk.0 »| 40.0 Gb, VMware Virtual IDE Hard Drive
L

N [Type |aciive [File Sysiem  [volume label |Size |Drive leners |
0  Primany Yes NTFS WinXP 3.0Gb (=5

1 Primary Mo NTFS Applicaton 938Gk E

2 Primary No BackupCapsul [Ho label) 100 Gb <Mone=

3 Primary Mo Free 17.2Ghb <Mones

9. Click the Edit Letters button to correct an existing drive letter or assign a new one in the Windows System
Registry.

Partitians List

Drive letters it. Information about drive letiers

the Windows installation seleced.

Lenears
Basic Disk 0 Drive
M |[Type | Drive leners
0 Primary b <None:s
1  Primary 133 E:
2 Primary Add Gh Mo
3 Primary — Gb <None=
Recommended to try - C:. If used,
you can release itin Leters Map.

Close

==

10. Once you’ve assigned the appropriate drive letter, close the dialog, then click the Apply button.
11. Confirm the operation.

ﬂ Apply the changes?

A

v J[ ™ |

12. After the operation is completed click the Report button to see a well informative summary page. The program

also enables to store the resulted report. To do that, just press the Save button and choose the exact location in
the opened dialog.

Copyright© 1994-2011 Paragon Software Group. All rights reserved.



63

| Reporting

Paragon Boot Correcior's Report
Cperations performed

Operation 21 Change diive leners

Partition targesed: Hard disk 0, Panition 0
Info: System Root folder is ™~ fpuser, If
Status: Successiul hnd make
Daie and Time: 2009 Jan 14 Wed 16:14:16

e Togo o the beginning, click here

13. Click the Finish button to close Boot Corrector.

14. Reboot the computer.

Copying of data from the corrupted system disk to another hard disk

To retrieve valuable information from your hard disk and copy it to another hard disk when the system fails to boot,
please do the following:

1. Connect the second hard disk to the computer.

2. Start up the computer from our Linux/DOS wiping media.

Wiping Media Builder can help you prepare our environment either on a CD/DVD disc or a

2 thumb drive.
To automatically boot from the wiping media please make sure the on-board BIOS is set up
to boot from CD/USB first.

3. Inthe boot menu select Normal Mode to use the Linux environment (more preferable) or Safe Mode to use the
PTS DOS environment (in case you’ve got problems with Linux). Moreover you’ve got the option to boot into the
Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware incompatibility. In this case,
only the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This mode has
simple graphics and a simple menu.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

4. |n the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.
5. On the Wizard's Welcome page, click the Next button.

6. Select a disk where the files you need are stored from the pull-down list in the right pane of the page.
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Source

( (NTFS, 0 on Disk 0) (WinX® v

W My computer
' / (Rootdin
W MyComputer (My computer)
N /mnt (Mounted resources)
™ /mnydisk (Local disks)
i] W /media (Removable disks)
$ IDE CD/DVD (NECVMWa VMware IDE CDR1

vml
“w* D)\ (NTFS, 1on 2isk 0) (Application)

e E\ (BackupCapsule, 2 on Disk 0) (UFSD dis

T v

7. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.

9.

Clipboard Source
] /mntdisk/hdal/Documents and Settin [user v|
(3 imntdiskmd alDocuments and Settin . ~
J Application Data
) Cookies
) Deskwop
@ ) E-Mail Database
@ ) Favorites
J Local Settings
) My Documents
) NetHood
) PrintHood
< > ) Recent =
Total data size: nfa [ cax | |  Rename(F6) | [  Delw(F® |

Click the Calc button to estimate the resulted data size.

On the Select Destination Type, choose the way the data will be stored. Select the Save data to any local drive
or a network share item.

Please select how would you like o save the data:

(%) Save data to any local drives or a network share
Cheose this aption if you want 1o save your data wo lacal
maumted or physical panition, 1 USB or FireWare exernal
drives and to a mounted network share, You will be prompted o
choose a lecation you want i sawve the archive 0.

) Burn data to COYDVD

Choose this optian if you want the Wizard 1o burn the data o
Car DVD. You will be prompied 1 choose a CD or DVD RW
drive.

On the Select Destination Path page, select a hard disk to copy the data to by pressing the standard browse
button [...].

Select path

| minydisk/hda2 |B

Space avallable on destination: 8.6 Gb

Totaldata size: nja Calk

10. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the

operation.
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11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

Operations list: Suboperation progress

1 Transfer user data LA AL LA L LA AL LA AL LA LAl L AL LLIiillL]
Operation progress

.......................................................................

Time elapsed:  00:00:03 Time w0 finish 00:00:00

Copied so far 17.0 Mb

Overall progress

T

Transfering “/mntdisk/hdal/Documents and Settings/User/E-Mail Database” © "/mntdisk/hd a2/E-Mail Data
Transfering "/mntdisk/hdal/Documents and Settings/User/My Documents® to “/mntdisk/nda2/My Document
All operations have been finished

12. After the operation is completed, close the wizard by pressing the appropriate button.

13. Turn off the computer.

A This operation can also be accomplished with our wiping media.

Burning of data from the corrupted system disk to CD/DVD

To retrieve valuable information from your hard disk and burn it to CD/DVD when the system fails to boot, please do the
following:

1. Start up the computer from our Linux/DOS wiping media.

Wiping Media Builder can help you prepare our environment either on a CD/DVD disc or a

f thumb drive.
To automatically boot from the wiping media please make sure the on-board BIOS is set up
to boot from CD/USB first.

2. Inthe boot menu select Normal Mode to use the Linux environment, since it’s the only mode that enables to
burn CD/DVD discs.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Inthe Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.
4. On the Wizard's Welcome page, click the Next button.

5. Select a disk where the files you need are stored from the pull-down list in the right pane of the page.
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Source

CA\ (NTFS, 0 on Disk 0) (WinX® v

W My computer
' / (Rootdin
W MyComputer (My computer)
M /mnt (Mounted resources)
™ /mnydisk (Local disks)
z] W /media (Removable disks)
} IDE CD/DVD (NECVMWa VMware IDE CDR1

vml
“w* D} (NTFS, 1o0n 2isk 0) (Application)

e E\ (BackupCapsule, 2 on Disk 0) (UFSD dis

=3 ntidr ],,

6. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.

Clipboard

Source

(77 /mntdisk/ndal/Documents and Settin

8.

9.

5 /mnydisk/ndalDocuments and Settin =% ~

=
=)

L) Application Data
) Cookies

) Deskwop

) E-Mail Database
) Favorites

J Local Settings
2 My Documents
) NetHood

) PrintHood

) Recent

Lex] |

Click the Calc button to estimate the resulted data size.

< >

Total data size: n/a Rename (F6) | [ Delew(Fa |

On the Select Destination Type, choose the way the data will be stored. Select the Burn data to CD/DVD item.

Please select how would you like 1o save the data:

) Save datato any local drives or a network share

Choose this optien if you want o save your data o local
maunted or physical panition, o USB or FirrWare external
drives and o a mounted network share. You will be prompied w0
choose a locatian you wanm 1 save the archive .

(%} Burn data 1o CODVD

Chaase this option if you want the Wizard o bum the data 1o

C0 or DVD. You will be prompied o choose a CD or DVD RW
drive.

On the Choose a Recorder page, select a recorder from the list of available devices and then set a volume label
by entering it in the appropriate field.

Sebect a recorder o burn data s

Vendor [Product [Type |
Optiare DVD RWAD-7 1704 CO-R; CO-AW, DVD-R
Volume label; [my Dand |

On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the
operation.
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10. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

Operations list Suboperation progress

1: Transfer userdata 1 J

Operation progress

I..-.....--.....u......] ]
Time elapsed.  00:00:07 Time 10 finish 00:00:16

Copied so far: 5.0 Mb
To copy 12.0 Mb

Overall progress

IRRRERRERERERRES

Creating compilation image

Used burner: DVD RWAD-7170A Vendor: Optiarc
Session opening

Data burning...

11. After the operation is completed, close the wizard by pressing the appropriate button.

12. Turn off the computer.

A This operation can also be accomplished with our wiping media.

Hard Disk Utilization

To irreversibly destroy all on-disk information without any possibility to recover and that way providing the maximum
level of security, please do the following:

1. Inthe Main Menu: select Wizards > Wipe Hard Disk or Partition...

There are other ways to start up this function, please consult the Interface Overview
chapter to know more on the subject.

2. Onthe Wizard's Welcome page, click the Next button.

3. Select a hard disk, the data of which you want to wipe out.

Please choose an object for wiping. R can be 3 whole hard disk, 3 single parttion or a block of unaliocated space. You
can set (0 wipe all data on the padition or only unoccupied space on £ (see the next step)

[Mcmu*omm.vm“muasscm Disk Dev)
|
i.q_)JLocthsk(C:) lg_)}dda(Z:)
| MM 222 3GB NTFS 217GB NTFS
Basic Hard Disk 1 (VMware, VMware Virtual S SCS| Disk Dev)

@) Local Disk ()

4339 GB NTFS
Basic GPT Hard Disk 2 (VMware, VMware Virtual S SCSI Disk Dev)

I l ©) (Unallocated)
5638 GB
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4. Onthe Wipe Mode page, select the wipe out all the data to irreversible destroy all on-disk information.
o [Wioe out 8l the data |

Choose this option £ you want 10 destroy completely all the data on the selactad object

Choose this option £ you want 10 destroy the traces of data that may have been left after an ordinary delete
operation

5. On the Wipe Method page select a specific data erasure algorithm or choose to create a customized one (in our
case we prefer to use a certified military standard).

@ | Specfic dgomhm |

M
You can see the algorthm descrption and set the laval of verfication on the naxd page
Create your own Data Santization method

You can creata your own Data Sanitization method

.A The list of supported military and government standards may vary for your product.

6. The next page of the wizard enables to get detailed information on the selected algorithm, choose whether to
carry out residual data verification or not specifying the percentage of sectors to check and estimate the time
required to accomplish the operation.

Wipa mathod

US DoD 5220.22-M

Orvararite all addressable lbcations with a character, is complemant, then a random charactar and veefy.
Erase passes count: 3
Verfy passes count: 1

o] | ety wipe resuls

Parcentage of sectons to check: | 100

Approvimate wips time: 14:02-40

."'H:- 'T't:..: [T 4 '.-1¢"'.("; cm'p:e:e*,- or partly Oy BB g £ OF MECUCg DarCamags of saciors 1o cneex
Please note. &t would be a deviation from US DolD 5220.22-M

7. Review all parameters of the operation and modify them if necessary.

Yiour hard disk bafore the changes

Basic Hard Disk 0 (VMware, VMware Virlual 5 SCS1 Disk Dev)

Il @ Local Disk (C) I

B2 3 GE NTFS

@) data (Z)

217 GB NTFS

Your hard disk shar the changes

. Basic Hard Disk 0 (VMware, VMware Virtual 5 5051 Disk Dev)

I @) (Unallocated)

4999 GE
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8. Complete the wizard and then apply the pending changes.

Extra Scenarios for WinPE

Adding specific drivers

Our WinPE 3.0 based environment offers excellent hardware support. Anyway you’ve got the option to add drivers for
specific hardware with a handy dialog.

To add drivers for specific hardware, please do the following:
1. Once you accept the agreement, you will see the Universal Application Launcher. Click Load Drivers.

2. Inthe opened dialog browse for an .INF file of the required driver package located on a floppy disk, local disk,
CD/DVD or a network share. Then click the Open button to initiate the operation

Look in; I [E] ga (oaanear (27) :J o K ¥
@ Hama Size Dt
=k [=] ga [ amnver) (23
Disk Drtves 3 B 0A_MT 9/25/2007 6:43:53 AM
+ TrTRane 4/16/200%
+ 22408
@ + AMatasha
Hatwerk Places i Aocls_PM200%
= A0S
+ Compatibility
4 Davescan E1B/200% 11:28:46 PM
=N= . T/E 2009 3:15:38 AM
. aard oo _windk Japevista_b 11375 BN18/72009 10:31:34 PM
=& Intal-iCH 5M18/2009 10:33:53 PM
= (5] Driver £/18/2009 10:33:53 PM
.EH’!CI:'I' BEKE 9122008 1:21:12 AM
@S TSKE 91272008 1:21:112 AM =|

Fles of ype: | inf Sles |

oo | _cows |

A To know how to map a network share, please consult the Configuring network scenario.

3. You will be notified on the successful accomplishment of the operation. Click Yes to load another driver or No to
close the dialog.
; ) Driver “z-/adjustos./divers/intel ich/driver/iashci inf" has

been loaded successhully. Would you like to load another
driver(z)?

A Our WinPE 3.0 environment is 32-based, thus you need to use 32-bit drivers for injection.
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Configuring network

If your local network has a DHCP server, a network connection will be automatically configured once our WinPE
environment has been started up. Otherwise you will need to do it manually with a handy dialog by providing an IP
address, a network mask, default gateway, etc. Besides with its help you can easily map network shares.

To manually set up a network connection and map a network share, please do the following:
1. Once you accept the agreement, you will see the Universal Application Launcher. Click Configure Network.

2. Inthe opened dialog provide an IP address, a network mask, default gateway, etc. for your network device.

Ethemet adapter: | intei(R) PRO/1000 MT Metwork Connection =l

IP address configuration
" Obtain an IP address automaticaly.

Rerew address | Felease addess

& Use the folowing IP address -
IP Address [17230 2¢ 12
Subnet Mask :  [255.255.255.0

Defaul Gateway : [172.30 24 254 Advanced...
s |

DMSANINS configuration
[ Obtain DNS senver address sutcmaticaly

DMS server : 17230 30 33 Pdvanced

' Obtain WINS server address automaticaly
Primary WINS server . [17230 30 33
Secondary WINS server: [0 0 0 0

Load fomfle | Savetofie | 0K fooy | Cancel |

3. Click the Network drivers tab to map a network share.

Drive | Network path | Ih:Hutmleh‘eI

4. Click Map Network Drive and provide all the necessary information to map a network share in the opened

dialog:

—Remote location mapping
Anetwoek share || )
Map to drive lefter - | =

T Make permanent connection

¥) Connact as user oK Cancal

Copyright© 1994-2011 Paragon Software Group. All rights reserved.



71
e Click the standard browse button [...] to browse for the required network share or manually enter a path to
it;
o Define a letter from the pull-down list of available drive letters;

e Click the Connect as user button at the foot of the dialog page to specify a user name and password to
access the selected network share if necessary.

By clicking Disconnect Drive... you can delete an existing network share if necessary.

Click the Network identification tab to change a network name of your computer (generated automatically) and
a workgroup name.

[ TilNetwodk adapters ), (1o Netwodcdives ) 5 tietnock centicaton
Computer Name :  [MININT-24LBEPF

Waorkgroup : [WORKSROUP
Frimary DINS suffic : |

By default, the wizard saves all network settings in the netconf.ini file located on the WinPE RAM drive, thus it
will only be available until you restart the computer. However, you can just once configure your network device
and then save this file to some other destination, for instance a local drive, and this way avoid constant re-
configuration, just by providing a path to it. So Click Save to file to save the netconfig.ini file to the required
destination.

Network troubleshooter

Network Configurator includes a traceroute/ping utility that enables to get detailed information on particular routes and
measure transit delays of packets across an Internet Protocol (IP) network. So with its help you can easily track down

problematic nodes.

1.

If you need to ping some network host, please select Ping, then type in the required IP address or its name. Click
Start when ready.

oy Network utilties

Weity: | Prg =zl

Target: [w«me
[~ Ping the specied host untd stopped
™ Resolve addressas to hostnames
[T Number of echo requests to send; |1 -

i

Running ping www googie com
Pinging www | google com [74.125 43 .99] with 32 bytes of data
Reply from 74.125.43 99 bytes=32 time=46ms TTL=55
Reply from 74.126.43.99: bytes=32time~47ms TTLe56
Reply from 74,125.43.99: bytes=32 time=45ms TTL=56
Reply from 74,125 43 .99: bytes=32 tme=46ms TTL=56
Ping statistics for 74.125.43.99
Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),

Approximate round trp tenes in mili-seconds
Minimum = 45ms, Maamum = 47ms, Average = 46ms

ping www google com done
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e Ping the specified host until stopped. Mark the option to ping the chosen host for indefinite time;
e Resolve addresses to hostnames. Mark the option to display hostnames instead of IP addresses.

e Number of echo requests to send. By default the utility sends 4 echo requests, which you can modify
however.

2. If you need to trace a route to some network host, please select Trace route, then type in the required IP
address or its name. Click Start when ready.

sty Metwork utilties

L Tece ose K

Target: [wmguoglem
[~ Do not resolve addmessas to hostnames
[~ Madmum number of hops to ssarch fortaget: |1 o
™ Wat timsout miisaconds for each rephy: 1 s

4ims 43ms
209 85 254 153

7 ddms 44 ms

44 ms

6423317453

B S57ms

5ims Sdms

205 85 255,245

9 4ims

4Bms 49ms
b4 105, 16100 net [74.125,43.105]

Trace complete
0

tracer Wanw QOOgEE COM dons

e Do not resolve addresses to hostnames. Mark the option to display IP addresses instead of hostnames.

e Maximum number of hops to search for target. By default the utility goes through maximum 30 hops when
searching for the target host, which you can modify however.

e Wait timeout milliseconds for each reply. By default the utility waits 4 seconds for each echo reply
message. If not received within the timeout, an asterisk (*) is displayed.

Saving log files

The program enables to simplify the procedure of sending support requests to the Paragon Support Team. In case of
having difficulties with handling the program, you, with the help of this very function, can address the company support
engineers and provide them with all the information they need such as the disk layout, performed operations, etc. in
order to tackle the encountered problem. Information of that kind is stored in log files.

To prepare a log files package, please do the following:
1. Once you accept the agreement, you will see the Universal Application Launcher. Click Log Saver.

2. Inthe opened dialog browse for the required location of the log files package or manually provide a full path to
it. Click Save to initiate the operation.
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~oj]

Specify folder and file name for ZIP archive
Lock: | [5] Local Disk (C) B
Hame Size | Date
=[] Local Disk (C)
| B s anchive_db 372372011 6:310 AM
#- | PerfLogs 7/12/2009 6:37-05 PM
- |, Frogram Files 32272011 4:14:05 AM
#- Ju Users 1118/2008 10:54:18 AM
| B Windows 3172011 12:32:04 AM
B (B)CD Drive (D) PARAGON
#- [Z] Boot ()

Flename:  |Logs_201104-01_04-172p

& Read privacy statement

Log files do not contain any confidential information on the operating system settings or
the user documents.

Troubleshooter
Here you can find answers to the most frequently asked questions that might arise while using the program.
1. Itryto run an operation, but the program claims my partition is in use and suggests restarting the computer.

There are a number of operations that cannot be performed while your partition is in use (or locked in other
words). Please agree to reboot your machine to make the program accomplish the operation in a special boot-
up mode.

2. |lrun an operation and restart the machine as required, but it just boots back into Windows without
accomplishing the operation.

Please run 'chkdsk /f' for the partition in question.
3. | cannot create a new partition on the disk.
There can be a number of reasons for that:
e The program cannot create a new partition on a dynamic disk.

e The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert
a free space on an existing partition to a new partition.

4. | cannot copy a partition.
There can be a number of reasons for that:
- The source or target disk you select is a dynamic disk;

- 4 primary partitions (or three primary partitions and an extended one) already exist on the target disk.
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5. | need to copy a partition. But when selecting a place where to make a copy, | always get a crossed circle sign no
matter which partition is selected.

The program enables to copy a partition only to a block of un-partitioned space. If you don’t have a block of free
space on your hard disk, please delete or reduce an existing partition to accomplish the operation.

6. |cannot do anything with my USB flash drive. | get a crossed circle sign when trying to select any area on it.

Some USB flash drives don't have the MBR (Master Boot Record), that’s the cause of your problem. To fix the
issue please use the Update MBR function of our program or 'fixmbr' of the Windows installation disc to write a
standard code to your flash drive.

7. When trying to back up my system the program asks to restart the computer.
Most likely the Hot Processing mode is disabled. Please make it active in the program settings.

8. When backing up a partition with the VSS (Volume Shadow Copy Service) mode, the program throws "VSS could
not be started for processed volume".

Most likely you try to back up a FAT32 partition, which is not supported by VSS. Please use the Paragon Hot
Processing mode instead.

9. | cannot back up my hard disk to an external hard drive. Once started, the operation is aborted with the
following error: Hard Disk management, Error Code 0x1100a. What is wrong here?

The problem is that the Microsoft VSS service is set as the default Hot Processing mode in the program. But this
service has not been started in your WindowsXP/Windows2003/Vista. Please start this service (right click on My
Computer > Manage > Services > find Microsoft Volume Shadow Copy Service and make it active. Set also to
start it automatically).

10. When running a backup operation with the Paragon Hot Processing mode enabled, | get an error: error code
0x1200e "Internal error during Hot Backup"

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer's tool.
You can find a name of the tool you need here: http://kb.paragon-software.com

11. When running a backup operation with the Microsoft VSS mode enabled, | get the following error: error code
0x12016 "VSS: can't read volume data”

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer's tool.
You can find a name of the tool you need here: http://kb.paragon-software.com

12. When trying to back up to a network share, | get the following error: "i/o error" or "can't open/create file"
Please check whether you’ve got a permission to write to the selected destination or not.

13. When trying to restore a backup archive, | get the following error: "Can't restore to current selection" or
"Archive does not fit"

Most likely you're trying to restore a backup of the whole hard disk to a partition or vice versa.
14. | set up a timetable for a task, but it fails to execute.
There can be a number of reasons for that:

- Windows Task Scheduler does not work properly. Check whether it is so or not by scheduling a simple task (call
Notepad through scheduling);

- You don’t have permission to write to the selected backup destination.
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Glossary

Active Partition is a partition from which an x86-based computer starts up. The active partition must be a primary
partition on a basic disk. If you use Windows exclusively, the active partition can be the same as the system volume.

In the DOS partitioning scheme, only primary partitions can be active due to limitations of the standard bootstrap.

The term backup originates from the time when the best way to protect valuable information was to store it in form of
archives on external media. It's become now a general notion to mean making duplications of data for protection
purposes.

Bootable Archive is created by adding a special bootable section when backing up the data to CD/DVDs. Thus you will
be able to restore the data from these archives without having to run the program, but by simply booting from these
CD/DVDs.

Cluster is the smallest amount of disk space that can be allocated to hold a file. All file systems used by Windows
organize hard disks based on clusters, which consist of one or more contiguous sectors. The smaller the cluster size, the
more efficiently a disk stores information. If no cluster size is specified during formatting, Windows picks defaults based
on the size of the volume. These defaults are selected to reduce the amount of space that is lost and the amount of
fragmentation on the volume. A cluster is also called an allocation unit.

Extended Partition is a partition type you create only on a basic MBR (Master Boot Record) disk. Extended partition is
used if you want to create more than four volumes on a disk, since it may contain multiple logical drives.

File System Metadata. The servicing structures of a file system, which contain information about allocating files and
directories, security information etc, are named the file system metadata. It is invisible for users and regular
applications because its accidental modification usually makes a partition unusable.

Hard Disk Geometry. Traditionally, the usable space of a hard disk is logically divided into cylinders, cylinders are
divided into tracks (or heads), and tracks are divided into sectors.

The triad of values {[Sectors-per-Track], [Tracks-per-Cylinder], [Amount-of-Cylinders]} is usually named the Hard Disk
Geometry or C/H/S geometry.

Tracks and cylinders are enumerated from "0", while sectors are enumerated from "1". These disk parameters play an
essential role in the DOS Partitioning scheme.

Modern hardware uses an advanced scheme for the linear addressing of sectors, which assumes that all on-disk sectors
are continuously enumerated from “0”. To allow backward compatibility with older standards, modern hard disks can
additionally emulate the C/H/S geometry.

Hidden Partition. The concept of a "hidden" partition was introduced in the IBM OS/2 Boot Manager. By default, an
operating system does not mount a hidden partition, thus preventing access to its contents.

A method of hiding a partition consists in changing the partition ID value saved in the Partition Table. This is achieved by
XOR-ing the partition ID with a 0x10 hexadecimal value.

Master File Table (MFT) is a relational database that consists of rows of file records and columns of file attributes. It
contains at least one entry for every file on an NTFS volume, including the MFT itself. MFT is similar to a FAT table in a
FAT file system.

MBR & 1st track of the hard disk is the Oth sector of the disk. MBR (Master Boot Record) contains important
information about the disk layout:

- The used partitioning scheme;
- The starting records of the Partition Table;

- The standard bootstrap code (or the initial code of boot managers, disk overlay software or boot viruses).
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Generally, the Oth sector is used for similar purposes in all existing partitioning schemes.

The MBR capacity is not sufficient to contain sophisticated boot programs. That’s why the on-boot software is allowed
to use the entire Oth track of the disk. For example, boot managing utilities such as LILO, GRUB and Paragon Boot
Manager are located in the Oth track.

Partition ID (or File system ID) is a file system identifier that is placed in the partition. It is used to quickly detect
partitions of supported types. A number of operating systems completely rely on it to distinguish supported partitions.

Partition ID is saved in appropriate entries of the Partition Table and takes only 1 byte of space.

Partition Label (or Volume Label) is a small textual field (up to 11 characters) that is located in the partition's boot
sector. This value is used for notification purposes only. It is detectable by any partitioning tool including the DOS FDISK
utility.

Modern operating systems save it within a file system, e.g. as a special hidden file. Thus it is able to contain a relatively
large amount of text in multiple languages.

Partitioning Scheme is a set of rules, constraints and format of the on-disk structures to keep information on partitions
located on a hard disk.

There are known several partitioning schemes. The most popular of them is the so-called DOS partitioning scheme. It
was introduced by IBM and Microsoft to use multiple partitions in the disk subsystems on IBM PC compatible
computers.

Another popular partitioning scheme is the so-called Logical Disks Model (LDM) that originates from the UNIX
mainframe systems. Veritas Executive accommodates a simplified version of LDM to the Windows 2000 operating
system.

Windows 2000 and XP support two quite different partitioning schemes: the old DOS partitioning scheme and the new
Dynamic Disk Management (DDM). The problem is that earlier versions of Windows do not support DDM. In addition,
most hard disk utilities do not support it as well.

Recovery Media is a CD/DVD disc, a USB flash card or even a floppy disk from which you can boot for maintenance or
recovery purposes.

Root Directory is the top-level directory of a formatted logical drive to include other files and directories. In modern file
systems (Ext2/Ext3, NTFS and even FAT32) it does not differ from other directories. This is not the case for old FAT12
and FAT16 file systems.

Serial Number. In the DOS partitioning scheme, every hard disk and every partition has a 32-bit serial number
represented by an 8-figure hexadecimal value. It is stored in the MBR and its value is assigned when the MBR sector is
initialized by Microsoft standard disk managing tools, such as Windows Disk Administrator and the FDISK utility.

In fact, a hard disk's serial number is not important for most operating systems and software. It is known that Windows
NT, 2000 and XP store its value in the database of assigned drive letters.

A partition's serial number is stored in its boot sector (in FAT16, FAT32 and NFTS file systems). Its value is assigned when
the partition is formatted. It does not play an important role for most operating systems and software as well.
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